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Materials in this Guide 
Welcome to CourseWorks® version 8.0! In this three-ring binder you will find 
three things relating to CourseWorks®: 
 

• A CD containing the CourseWorks® learning management 
system (LMS) software and its documentation. 

• Information on how to access the CourseWorks® v8.0 Trainer's 
Guide (on the CD). 

• Information on how to access the CourseWorks® v8.0 Student's 
Guide (on the CD). 

We have done a number of things to make CourseWorks® v8.0 as easy to 
use as possible. The CourseWorks® learning management system is menu 
driven, and incorporates a "Help" document. However, for easy reference we 
have also provided information about all of these features in the Trainer's 
Guide. (If you have questions on the materials in this package, or the 
operation of CourseWorks® v8.0 itself, you should contact the distributor from 
whom you purchased CourseWorks®.) 
 
The CourseWorks® CD contains two components: 
 

• The Learning Management System (LMS) - This is the "core" of 
CourseWorks®. Using this system you can do things such as set 
securities, define logins and activate optional features that can be 
used with a course. This system also allows you to track 
employee/student performance by recording information such as 
the amount of time it has taken them to complete a course, test 
question results and the like.  The CourseWorks® learning 
management system also acts as the "platform" software that 
allows you to play the courses themselves. 

• A copy of the CourseWorks® documentation in PDF form – This 
includes the Trainer's Guide and the Student's Guide, and can be 
accessed using Adobe Acrobat Reader. 

As you start using CourseWorks® you will need to make some decisions 
about how to employ its capabilities. For example, there are several 
approaches that can be used to install courses on your computer, each with 
its own advantages. 
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Additionally, you will want to consider what type of "security" you want to 
employ with CourseWorks®. For instance, you probably won't want to give 
employees/students access to the learning management system portion of 
CourseWorks®... reserving these capabilities for the people who are 
overseeing and administering your facility's training activities. The materials 
in this package will help you think through these types of questions and make 
decisions that result in your training activities running smoothly and 
efficiently. 
 
One of the first things you should do after receiving this package is to 
thoroughly read the Trainer's Guide. Not only will it help you to understand 
the capabilities in CourseWorks®, but it will help you decide how to address 
the training issues within your organization. 
 
If you still have questions about how to set up and administer your training 
activities, or the functioning of CourseWorks® itself, contact the distributor 
from whom you purchased CourseWorks®. They will be glad to help you. 

Organizing and Administering Your Training 
Activities 
The way you organize and administer your training activities, as well as how 
you use CourseWorks® to facilitate and control those activities, can have a 
significant impact on the success of your training activities. You will want to 
give a good deal of thought as to how you schedule employees'/students' 
training, track test scores, generate reports and the like. 
 
One of the most important early issues you will need to deal with is how to 
have your facility's employees/students access the courses you are using. 
You will want to consider things like security, limiting access to specific 
courses and whether or not you want to have particular employees or groups 
of employees take a predetermined list of courses.  
 
This is tied to determining what features and options within the 
CourseWorks® learning management system you want to use, including 
setting security, establishing login requirements and procedures, setting up 
curricula, scheduling your employees/students for training courses, etc. You 
will want to consult the "Using CourseWorks® at Your Facility" section of this 
guide to make these determinations (if you have questions regarding the 
capabilities in CourseWorks®, or how to use the features and options that are 
available, call the distributor from whom you purchased CourseWorks®). 
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You will also want to start thinking about how you will be using the tracking 
and recordkeeping and capabilities within the learning management system, 
and what type of reports you would like to generate. This information is also 
helpful in determining which employees are qualified to move into new 
positions, who is eligible for promotion, and to legally establish that 
employees have, in fact, received training in topics such as safety and 
regulatory compliance. Remember that agencies such as OSHA are placing 
an increasing emphasis on documenting that employees have received the 
training the agencies require. 
 
The functions in CourseWorks® can help you with all of this, and you will want 
to understand its capabilities thoroughly. 
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Introduction to CourseWorks® 
Overview 
CourseWorks is the learning management system (LMS) that is used with 
courses in your Interactive CD-ROM Training Library. CourseWorks® is an 
easy to use, comprehensive suite of programs for managing the delivery, 
administration and authoring of CD courses. With CourseWorks® an 
organization can set up an interactive CD-ROM training environment to 
handle student enrollment and scheduling, security, tracking student 
performance and training certification. 
 
This guide is designed for people who are performing training 
administration using CourseWorks®. Some organizations may have one 
person designated to perform as the CourseWorks® administrator, or 
several people may share the administrator tasks. 
 
An administrator can literally have CourseWorks® in its simplest form 
running in several minutes, with a few mouse clicks… or they may decide 
to use a number of the optional capabilities in CourseWorks® to configure 
it to meet their organization's particular needs. Even then, configuring the 
CourseWorks® learning management environment is fairly straightforward 
and does not require a tremendous amount of time.  
 
If you will be acting as your organization's CourseWorks® administrator, 
you should review this guide in order to learn about the many capabilities 
in CourseWorks® before your students take any courses. For instance, 
CourseWorks® has a "curriculum" feature that provides an easy means for 
grouping courses and enrolling many employees at one time, which you 
may want to use. 

CourseWorks® Program Group 
With CourseWorks® an organization can configure its interactive training 
environment to suit its particular needs. The programs available in 
CourseWorks® where this is done include: 

• Setup 
• Build8 
• TrackPro 
• Deliver 
• Build Lite 
• CourseWorks® Help 
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Each of these programs corresponds to an icon in the CourseWorks® 
program group and is explained in detail in this documentation. 

 

Setup 

 
The administrator uses Setup to install, set up and delete CourseWorks® 
courses. Setup is used to configure each course individually by enabling 
or disabling optional course-related features. Some of these features 
include: 

• "Pre- and Post- Tests" – allow the administrator to create 
tests, specify the number of questions to include, and specify 
the tests' passing scores. 

• "Assessment Tests" – allow the administrator to give a student 
the ability to "test out" of various chapters in each course, by 
creating an initial test that includes questions from each 
module.  If the student answers the questions correctly for the 
respective chapter, they have the option to skip that chapter. 

• "Skip Ahead" – permits students to "skip" out of the video 
segment they are watching before it has finished playing, and 
move on to the next part of the course. You can also skip 
roadmaps, objectives and review menus.  

• "Reverse" – allows students to repeat the previous course 
element. 

• "Certificate" – lets students print out a "Certificate of 
Completion" immediately after completing the course. 

*Detailed instructions on how to use these features can be found 
in the "Course Setup Options" section of this guide. 

 

 11 



 
 

TrackPro  

 
TrackPro is used to perform most of the CourseWorks® administrative 
functions. The administrator uses TrackPro to set up and maintain the 
training database containing student and course data, as well as to 
configure the training environment at the systems level. Using TrackPro 
the administrator can send "messages" to students who are using the 
system, set passwords and login requirements, and control access to 
courses and curricula. 
 
An administrator can also use TrackPro to establish login procedures, 
specify the Deliver "Tic-Tac-Toe" menus that students see when they log 
in, and trigger the printing of training certificates. TrackPro also lets the 
administrator review and print reports and perform other database tasks 
such as importing and exporting student demographic data. The 
administrator can also monitor students who are logged in to 
CourseWorks®, as well as log off inactive users. 
 
TrackPro's "scheduler" function is a great tool for monitoring the continual 
certification requirements that some organizations and industries must 
adhere to. With the scheduler feature the administrator can establish the 
start and end dates between which courses are to be taken as well as 
specify a course's "recertification period" (a time frame in which a student 
must retake a course, such as annually). 

Deliver 

 
Students use Deliver to access their courses. When Deliver starts up the 
student will typically see a Tic-Tac-Toe menu of the training courses or 
curricula that are available to them. 

 12 



 
 

  
 
 
Build8 

 
 

Build8 is authoring software that can be used to create new fully functional 
interactive courses…as well as customize existing CourseWorks® 
courses.  
 
This CourseWorks® CD includes a "demo" version of this Build8 authoring 
software that allows you to explore all of the functions of Build8. However 
you will not be able to save any newly created courses until a license to 
Build8 is purchased.  
 
CourseWorks® also includes a "limited" version of Build8, called "Build 
Lite" at no charge. This limited version of the Build8 software can be used 
to customize CourseWorks® courses that you have purchased and that 
have been installed to your CourseWorks® system.   
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Help 

 
This program displays the CourseWorks® Trainer's Guide. The Trainer's 
Guide is in a searchable Microsoft Word format and includes instructions 
for most of the common tasks that will be performed when using 
CourseWorks®. 
 
The Trainer's Guide is accessible by clicking on any of the Help buttons 
that appear throughout CourseWorks®. Once the Trainer's Guide is 
displayed, a "Search" box will appear at the top of the page. Simply enter 
the topic you would like to find information on and the system will 
automatically take to you the section of the Guide that contains this 
information.  

Documentation Conventions 

Menu Notation 
Instructions in this guide that are directing you to choose from menus will 
be written with a triangle () symbol separating each menu selection or 
step. 
 
For example, rather than say… "select 'TrackPro', and from that menu 
select 'Administration', and then select 'Pre-Enroll Students'"… the 
instructions will be written in this shorthand notation: 
 
Select [TrackPro]  [Administration]  [Pre-Enroll Students]. 
This means the same as… 
  

Select   then   
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Terms and Definitions 
To avoid writing "(s)he" or "s/he", we will generally use the pronoun "she" 
when referring to an administrator and "he" for a student. (We believe that 
about 50% of training administrators are female and 50% are male and 
that the same percentages are true for students. But we just couldn't bear 
to write "(s)he" or "she/he" everywhere!) 

Administrator 
Throughout the guide we use the term "administrator" to refer to the 
person(s) charged with administering the organization's computer-based 
training environment.  

Button 
A button is used to invoke its command, i.e. . Some buttons may 
appear with one letter in its text underlined. When that is the case, you 
can also press the  key on your keyboard and the corresponding letter 
to invoke the command. For example, the  button has its "P" 
underlined. In this case you would press  and P in order to invoke the 
"properties" command. 

Check Box 
 

Clicking on a check box creates a checkmark in the box and enables the 
feature described in the box. Clicking on a check box that already has a 
checkmark in it will "deselect" it (disable that feature).  

Concurrent Accesses 
We use the term "concurrent" to describe the situation when more than 
one student is accessing CourseWorks® on a network at the same time. In 
a networked environment, the number of anticipated concurrent users 
usually determines how many licenses of CourseWorks® and course 
licenses will be required. 
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Curricula and Subcurricula 
The word "curriculum" is used to refer to one group or set of courses. 
Whenever we refer to more than one curriculum, we will use the term 
"curricula". CourseWorks® also allows the administrator to further refine 
the grouping of courses into "subcurricula".  
*See "Curricula" for details. 

Dialog Box 
In Windows, a "dialog box" prompts the user of a program to select 
options. For example, most Windows programs have a "Print" dialog box 
that contains drop-down menus, buttons, and check boxes that allow you 
to specify things such as where you want to print to, how many copies to 
print, etc. You'll encounter this type of box in some of the CourseWorks® 

functions, such as the "scheduling" feature. 

  

Dragging 

 
Drag means to hold down the left mouse button and then, while holding it, 
move the mouse and release the button at a new location 
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Drop-down Menu 

 
Drop-down menus are used to display a list of available choices. You click 
on the  to expand the list. To select an item from the expanded list, you 
then click on it. 

Light Bulbs ( ) 
Light bulbs can be found in bold type and are "boxed". They denote a "tip" 
that will help you in using CourseWorks®. 

Network Drive 
Some organizations use a "client/server" network configuration and others 
use a "peer-to-peer" network. We use the term "network" to refer to either 
type of network, since CourseWorks® works equally well with both. The 
term "network drive" will be used to indicate the drive that CourseWorks® 
resides on, regardless if the drive is a network drive in a client/server 
network or a shared drive in a peer-to-peer network. 

Radio Buttons 
CourseWorks® uses "radio buttons" to prompt the user to make a choice 
from a series of mutually exclusive choices. The term "radio buttons" 
implies that these "buttons" behave in a similar fashion to the buttons on a 
car radio. (When you push in a channel selector button the radio switches 
to the channel assigned to that button. Only one button can be activated 
at any one time). 

  or   

In this example, there are two radio buttons shown. In the left graphic, the 
"Start date" is the selected option whereas in the right graphic the user 
has clicked on the "End date" option. 

Select 
"Select" indicates that you are to highlight an item in a list or menu, then 
click with the mouse on that specified item. 
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WARNING!  
Warnings are provided in bold type and are "boxed" so that they won't be 
missed. Warnings generally tell you about things that should not be done 
within CourseWorks® because they can have dire consequences.
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Installing/Removing CourseWorks®  
Overview 
There are three ways that the CourseWorks® learning management 
system can be installed: 
 

• A new or upgrade installation of CourseWorks® to a local 
computer. 

— This type of installation is performed when you are 
installing CourseWorks® on a single computer that is 
to be used as a workstation. See "New or Upgrade 
Install of CourseWorks® on a Standalone Computer" 
for more information. 

 
• A new or upgrade installation of CourseWorks® over a network 

to a server computer. 
— This type of installation is performed when you are 

installing CourseWorks® on a server computer on 
your network and will be accessing the training from 
client computers on your network. See "New or 
Upgrade Install of CourseWorks® over a Network" for 
more information. 

 
• A CourseWorks® network client installation.  

— This type of installation is used to configure a 
network computer to be a CourseWorks client.  
CourseWorks® must have already been installed by 
one of the 2 previous methods described.  See 
"Creating a CourseWorks® Client" for instructions. 

 
• Removing CourseWorks®. 

— See "Removing the CourseWorks® Installation" for 
instructions. 

 
All CourseWorks® installations require that the user have full 
administrative rights (read, write, erase, create and modify) through the 
Windows operating system to the drive that CourseWorks® is being 
installed to.  In addition if the option is available with your version of 
Windows, the installation must be in "Run as Administrator" mode.  
This is necessary because the operating system must be able to install 
various Microsoft components that require special administrative rights. 
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Remember, as with any software you should close all open windows 
before starting the installation process. Specific instructions for each type 
of install are provided in the next sections. 

New or Upgrade Install of CourseWorks® on a 
Standalone Computer  
To perform this type of installation: 
 

1. Click on the Computer  icon on your desktop and 
double-click on the CD-ROM drive to open the contents of 
the CD.  Then double-click on the "setup.exe" file to initiate 
the install process (if applicable to your Windows 
configuration right-click and choose "Run as 
Administrator"). 

2. The next screen to appear will be the CourseWorks®8 
Installation Wizard screen.  Click the  button: 
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3. When the license agreement appears, you must accept this 
agreement to continue with the installation (if you do not agree 
to the terms in the agreement, return the software to the 
distributor) and click on the  button: 

 
4. The next screen to appear is a “Readme” screen: 

WARNING! 

If you are currently using Courseworks 7 and are 
upgrading to Courseworks 8, DO NOT remove 
CourseWorks 7, either manually or through the Control 
Panel “add/remove” function. Doing so will delete your 
database file which will be used by Courseworks 8. 
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5. You will then be prompted to choose the "destination" 
folder for the CourseWorks® software.  The software can 
be installed to the default folder on the local machine 
"c:\crswrks8" by clicking : 
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6. Or you can browse your computer files to choose a 
different location on the local machine by clicking the 

 button: 

          
 

7. Clicking the  button presents another dialog box 
allowing you to specify a different location by using either 
the directory tool buttons or by typing in the full path in the 
'path of CW server' edit box, then click the  
button: 
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8. Verify that the CourseWorks® installation folder is correct 
and then press the  button: 

           
 

9. The next screen allows you to choose the setup type.  
Since this is the initial installation of CourseWorks® 8, 
choose 'Install CourseWorks SERVER software' and click 

: 
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10. Verify that the setup type and destination folder are 
correct and click  to begin the installation 
process: 

           
 

10. The completion dialog box will appear when installation is 
complete. Click  to end the process. 
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New or Upgrade Install of CourseWorks® over a 
Network to a Server Computer  
To perform this type of installation: 
 

1. Click on the Computer  icon on your desktop and 
double-click on the CD-ROM drive to open the contents of 
the CD.  Then right-click on the "setup.exe" file and choose 
"Run as Administrator" to initiate the install process. 

2. The next screen to appear will be the CourseWorks®8 
Installation Wizard screen.  Click the  button: 

           
 

3. When the license agreement appears, you must accept this 
agreement to continue with the installation (if you do not 
agree to the terms in the agreement, return the software to 
the distributor from whom you made your purchase): 
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4. The next screen to appear is a “Readme” screen: 

WARNING! 

If you are currently using Courseworks 7 and are 
upgrading to Courseworks 8, DO NOT remove 
CourseWorks 7, either manually or through the Control 
Panel “add/remove” function. Doing so will delete your 
database file which will be used by Courseworks 8. 
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5. You will then be prompted to choose the "destination" 
folder for the CourseWorks® software.  You must choose a 
location on the network machine by clicking the  
button: 
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6. Clicking the  button allows you to specify the 
network location by typing in the full UNC path of the 
networked computer location in the 'UNC path of CW 
server' edit box, then click the  button: 

           
 

7. Verify the CourseWorks® installation folder and then press 
: 

           
 

 29 



 
 

8. The next screen allows you to choose the setup type.  
Since this is the initial installation of CourseWorks® 8, 
choose 'Install CourseWorks server software' and click 

: 

           
 

9. Verify that the setup type and destination folder are correct 
and click  to begin the installation process: 
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10. The completion dialog box will appear when installation is 
complete. Click  to end the process. 

           
 

Creating a CourseWorks® Client   
To perform this type of installation: 
 

1. Click on the Computer  icon on your desktop and 
double-click on the CD-ROM drive to open the contents of 
the CD.  Then right-click on the "setup.exe" file and choose 
"Run as Administrator" to initiate the install process. 

2. The next screen to appear will be the CourseWorks®8 
Installation Wizard screen.  Click the  button: 
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3. When the license agreement appears, you must accept this 
agreement to continue with the installation (if you do not 
agree to the terms in the agreement, return the software), 
then click  to continue. 
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4. You must choose the location where CourseWorks is 
installed on the network server by clicking the  
button: 

          
 

5. Clicking the  button presents another dialog box 
where you specify the network location of the server by 
typing in the full UNC path in the 'UNC path of CW server' 
edit box, then click : 
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6. Verify that the CourseWorks® installation folder is correct 
and then press the  button: 

           
 

7. The next screen allows you to choose the setup type.  
Choose 'Install as a CourseWorks client' and click 

: 
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8. Verify that the setup type and destination folder are correct 
and click  to begin the installation process:  

           
 

9. The completion dialog box will appear when installation is 
complete. Click  to end the process: 
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Removing CourseWorks® 
If you need to remove CourseWorks it is done through the Windows 
"Add/Remove Programs" feature in the Control Panel.  For more 
information using this method, consult your Windows operating system 
documentation. 
 
This option will remove the CourseWorks® program. It does not remove 
any of the installed courses or the student database. If you want to 
remove the student database, you will need to manually delete the 
database file on your computer's hard drive. You will need to use a 
Windows command to delete this file. 
 

Note: To delete, or remove, a CourseWorks® course, do 
not use this option but instead follow the 
directions in this documentation for removing a 
course. *See "Removing (Deleting) a Course" for 
details. 
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Using CourseWorks® at Your Facility 

Administrator Tasks… Overview 
In setting up the CourseWorks® training system, the administrator can 
choose to use some or all of the capabilities available in CourseWorks®, 
depending on how much control she wants over the training environment 
and use of the system. Each of these tasks can be completed quickly and 
easily. In this discussion we will assume she is using all of the capabilities. 

 

Most of these tasks don't necessarily have to be performed in a "fixed" 
order, but we do recommend that they be done in the sequence that is 
illustrated in the above diagram. Whatever order you choose to use, Step 
1, "Installing CourseWorks®", must always be completed first.  
 
After the administrator installs CourseWorks®, she will install and 
configure the courses that are currently owned by the organization (Step 
2). Later, when additional courses are either purchased or built, she will 
need to install and configure those courses as well.  
 
In Step 3 if the administrator wants to set up a "student database" she will 
either input the student demographic data into the CourseWorks® 
database or import it from an existing database that the organization is 
already using (such as a Human Resources Department database). 
 
The administrator has a number of options to choose from in determining 
how students are enrolled in courses (Steps 4 through 7). The simplest 
set-up lets students see all of the installed courses on one Tic-Tac-Toe 
menu in CourseWorks® Deliver. In this case, when a student logs in he 
sees buttons for all the courses. However, most organizations do not use 
CourseWorks® without first configuring the environment to meet their 
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specific needs, determining which courses each student should take and 
deciding what curricula the administrator should establish. 
CourseWorks® has several password and login options that an 
administrator should also set up before having students take courses 
(Step 8). 
 
Based on the login options that are chosen, the administrator can monitor 
the progress of the students on a regular basis, generate reports and print 
completion certificates (Step 9). The administrator can also use 
CourseWorks® to periodically review test results or perform other 
database tasks. 
 
Each of the nine main steps is discussed below and explained in more 
detail in its respective section in this documentation. 

Install CourseWorks® (Step 1) 
This step is similar to the installation of any new software. You install 
CourseWorks® just as you do other programs, using the "Run" command 
from the "Start" menu on the Windows taskbar (see the "Installing 
CourseWorks" section of this manual).  

 
*See "Installing CourseWorks®" for more details. 

Install Courses (Step 2a) 
Use the CourseWorks® Setup program to install courses from your CDs. 
(The courses cannot be properly installed and set up using the "Run" 
command from the "Start" menu on the Windows taskbar. They must be 
installed using the CourseWorks® Setup program). 

The Setup program and its icon are established during the CourseWorks® 
installation and appear under the CourseWorks® program group on the 
computer's desktop.  
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Select [CourseWorks® v8.0]  [Setup]. 
 
*See "Installing a Course" for details. 
 
Setup (Configure) Courses (Step 2b) 
Each course can be set up with an assessment test, pre- and post- tests 
and other course-specific features if desired. In the Course Setup 
process, the administrator can enable or disable course options such as 
"skip ahead", "reverse" and "course message". This does not necessarily 
need to be done when the course is initially installed, but it usually is. If 
you decide to change any of the setup options for the course after it is 
installed, you do not need to reinstall the course (Step 2a). 
 
Select [Setup]  [Setup a course]. 
 
*See "Configuring a Course" for details. 

Establish the Student Database (Step 3) 
Use TrackPro to set up your organization's student database. Five 
database fields are pre-defined. You can start using the default database 
"as is" and not make any modifications. But you might want to review your 
organization's data requirements when you first install CourseWorks® and 
add some database fields before enrolling any students into courses. 
 
Note: You may have more than one database in 

CourseWorks® v8.0. However, each database must 
have a unique "Site Name". 
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Select [TrackPro]  [Database]  [Database Field Configuration]. 
 

 As an alternative to starting a completely new training 
database, you can import data from your organization's 
existing non-CourseWorks® database.  See "Importing a 
non-CourseWorks database" for more information. 

*See "Student Database Fields" for details. 

Organize Courses into Curricula (Step 4) 
CourseWorks® is a "curricula-based" system in that CourseWorks® always 
considers a course to be part of a group of courses, i.e. a "curriculum". 
The default curriculum in the system is the "All Courses in the System" 
curriculum. So if an organization wants to enroll students in individual 
courses, or allow all students to access all of the courses in the system, 
the training administrator will not create any other curricula. However, 
there are a number of reasons that an organization may want to create 
additional curricula. 
 
By having courses grouped into curricula, access can be limited to 
specific groups of employees, in effect serving as a filter. The 
administrator can organize courses so that when a student logs in, he 
sees only those curricula that are relevant to his needs (a curriculum can 
consist of one course or many courses).  
 
Courses can be grouped into curricula for a number of reasons, creating 
groups of courses that are needed for certification or accreditation, 
courses that are needed to satisfy OSHA regulations, courses needed to 
qualify for job advancement, courses that are needed for orientation of all 
new employees, courses that are needed to familiarize employees with a 
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new system or procedure, courses that are needed by employees of a 
particular department or who have a particular job function, etc. Curricula 
can also be broken into smaller pieces themselves ("subcurricula") for 
even tighter control.  There is no limit to the number of subcurricula that 
can be created. 
 
The administrator can also benefit from using curricula, because if 
students are being pre-enrolled they can be enrolled into groups of 
courses (curricula) all at once rather than in just one course at a time. 
If the curriculum feature is used, the CourseWorks® Deliver environment 
can be set up so that when a student logs in he either sees a specific 
curriculum's Tic-Tac-Toe course list or a list of curricula that he is enrolled 
in. 
 

 

Select [TrackPro]  [Administration]  [Curricula Setup]. 
 

 If an organization sets up curricula, it should never enroll 
students in individual courses. Enrolling students in a 
curriculum automatically enrolls them in all courses 
included in the curriculum. 

*See "Curriculum Overview", "Selecting the Courses or Curriculum for 
Deliver" and "Login Procedures" for details. 
 
Enroll Students (Step 5) 
In CourseWorks® you can enroll students "by courses" or "by curriculum". 
Most organizations group courses into curricula. If you create curricula, 
we recommend that you do not enroll students in the individual courses. 
Enrolling students in a curriculum automatically enrolls them in all of the 
courses included in the curriculum. Generally it is a good idea to first 
establish and name your curricula, add the courses you want to each 
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curriculum (Step 4), and then enroll the students by "curriculum" rather 
than by course.  
 

 

*See "Curriculum Overview" and "Pre-Enroll Students" for details. 

Schedule Students (Step 6) 
TrackPro's "Course Scheduler" is a tool for setting up a student's course 
schedule. The administrator can establish start/end "availability" dates for 
any required course or curriculum. The administrator can also set up a 
"recertification" period, indicating when the student should take a specific 
course or curriculum again. This is a useful feature for ensuring that 
students meet any regulatory retraining or certification requirements that 
they might have. 
 

 

Select [TrackPro]  [Administration]  [Course Scheduler]  [Set 
Schedule]. 
 
*See "Scheduling Courses" for details. 
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Choose Login Options (Step 7) 
This capability coordinates closely with "Enroll Students" (Step 5). An 
organization has three main login options from which to select, depending 
on whether students are being enrolled by course or by curriculum.  
 
If an organization does enrollment by course, the administrator can 
require or not require the student to log in (by "logging in" we mean that 
the student will be prompted to identify himself by entering his Student 
ID). 
 

WARNING! 

If a student is not required to log in, the system will not 
record any training data for that student. 

When managing enrollments by course, the administrator can configure 
which courses will allow students to "self enroll" and which courses will 
require the administrator to "pre-enroll" the students. By allowing anyone 
to log in ("open enrollment") the administrator does not need to enroll the 
student. Deliver will even allow a student who isn't yet in the student 
database to not only enroll in the course but also input his own student 
demographic data (name, job title, etc.) into the student database. 
Remote sites that are not accessible to the training administrator 
frequently use this option. 
 
If an organization does enrollment by curriculum, Deliver normally first 
prompts the student for his Student ID and then lists all curricula in which 
the student is enrolled. 
 

 

Select [Setup]  [Course Setup]  [Enrollment/Login]. 
 
*See "Which Login Option is Best for My Organization?" for details. 

 43 



 
 

Establish Passwords (Step 8) 

 

Review Student Data (Step 9) 
The administrator can readily check on the progress of students via the 
many predefined reports that can be viewed and printed through 
TrackPro. For instance, an administrator can review scores and course 
completion data for all courses, all students, a single course or a single 
student.  
 
You can also create your own unique reports. The CourseWorks® "Report 
Wizard" feature assists you in this process.  

 

Select [TrackPro]  [Database]  [Create Database Reports]. 
 
*See "Reports" for details. 
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Other Administrator Tasks 
Other than the "report step", the nine administrator activities described 
earlier are typically completed in the initial configuration of your 
CourseWorks® environment. There are additional things that an 
administrator may decide to do later, after students have begun using the 
courses. These tasks are briefly described below. They are explained in 
more detail in their respective sections of this documentation. 

Backing Up the Student Database 
It is strongly recommended that you back up your database file on a 
regular basis. 
 

 You should back up your database on a daily basis. The 
backup must be performed when no one is using any of 
the CourseWorks® applications.  

 
 If you have installed CourseWorks® on a network, the 

backup database should be located on a different drive 
than where CourseWorks® is installed or on an external 
storage device, if possible.  

 
 If you installed CourseWorks® on a standalone computer, 

the backup database should be located on an external 
storage device, if possible. Otherwise it should be stored 
in a folder outside of CourseWorks®. 

Compacting the Database (for "Access"-type databases) 
Use the "Compact Database" command regularly to improve the 
performance and speed of your Access database.  
 
*See "Compacting the Database" for details. 

Certificates 
The administrator can print "Certificates of Completion" for students who 
successfully complete a course or have "tested out" of a course by 
passing the pre-test. 
 
*See "Student Certificates" for details. 
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Question Analysis 
An administrator can review or print out a list of the test questions 
associated with a course. 
 
Select [TrackPro]  [View]  [View Course Test Questions]. 
 
*See "View a Specific Question" for details. 
 
The administrator can also evaluate test questions to see how well 
students were able to relate to them. A report can be easily generated that 
shows the number of and percentage of students who answer each 
question correctly. 
 

 

Select [TrackPro]  [Database]  [Create Database Reports]. 
 
*See "Reports" for details. 
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TrackPro 

Overview 
An administrator uses TrackPro to define the training information 
environment at the system level, such as enrolling students into courses, 
grouping courses into curricula, scheduling courses, managing the 
organization's training database, and performing other training 
management functions. TrackPro also includes a powerful but easy-to-use 
reporting tool that provides many predefined reports, as well as lets the 
administrator design and print custom reports. 

Starting TrackPro 
To start TrackPro from the Desktop: 
 

1. Double-click on the CourseWorks® v8.0 folder on your 
desktop. 

 

2. Double-click on "TrackPro". 

 

View Menu 

Overview 
Many of the "View" menu commands affect the information that you see in 
the main TrackPro window. With this menu you can choose to view data 
by students, courses or curricula.   
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Status Bar and Toolbar 
The administrator has the ability to display or not display the TrackPro 
"Toolbar" and "Status" bar.  
 
The Toolbar is shown at the top of the TrackPro screen. 

 
 
The Status Bar is shown at the bottom of the TrackPro screen. 

 
 
These two options are similar to those used in any Windows program. 

View Options 
TrackPro has three main views… "Curriculum", "Student" and "Course". 
An administrator can easily switch views to display data as she needs to 
see it. 
 
Select a view based on the information you want. You can switch back 
and forth between the views by either using toolbar buttons, the menu, or 
by using the F2, F3, and F4 keys on your computer keyboard.  
 
The toolbar view buttons are marked with a briefcase for the "Curriculum 
View", a person for the "Student View" and a looseleaf notebook for the 
"Course View". 

     
 
After obtaining the desired view, it can be printed by selecting [File]  
[Print]. 
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Curriculum View 
Use this view to display curricula and their respective courses. When an 
administrator implements the curriculum feature, she groups courses into 
curricula and then enrolls students by curriculum, rather than by individual 
courses. When a curriculum name is selected, its courses are displayed 
on the right.  
 
*See "Curriculum Overview" for information on establishing curricula. 

 

Student View 
The administrator uses the student view to display a list of all of the 
courses in which a student is enrolled, responses to questions, test scores 
and the length of time the student took to complete each course. 

 

Student names display in the left windowpane. The highlighted student's 
course data displays in the right pane. Click on the "student icon" 
( ) adjacent to the student's name and/or the "+" and "—" 
symbols in the left pane to expand and contract the listing. 

 When installing a course, the "record only partial data" 
option can be selected to limit the amount of data that is 
tracked. This will cause only pre- and post- test and 
segment test results to be saved.  

*See "Record Only Partial Data" for details. 
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Course View 
In "Course View", course titles display in the left pane. Student training 
data displays in the right pane.  
 

 

Click on the "+" and "—" symbols in the left pane to expand and contract 
the listing for the desired course. 
 
Click on the student name in the left pane to review his performance 
statistics in the right pane. 

Reviewing Course Questions and Segment Test 
Results 
The administrator may view course (quiz) and segment test questions 
from several different perspectives. She may: 
 

1. View a specific question. 

2. Look at a student's response(s) to a specific question. 

3. View a report listing facility-wide performance on questions. 

View a Specific Question 
1. Select [TrackPro]  [View]  [View Course Test 

Questions]. 
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CourseWorks® displays the list of installed courses.  
 

 
 

2. Select the desired course. 

3. Click on the  button. 

The selected course's quiz questions and correct answers are 
listed. 

 

4. (Optional step) To print, select [File]  [Print]. 
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View Specific Question or Segment Test Responses for 
an Individual Student  

 
1. Select [TrackPro]  [View]  [Student View]. 

2. Double-click on the desired student.  The courses that 
student is enrolled in will appear under his name. 

3. Double-click on the desired course.  The results for the 
quiz questions and segment tests for the selected student 
can be found in the respective folders. 

4. Double-click on the Questions or Segment Tests folder. 

TrackPro displays session details and the student's responses for each 
quiz and segment test question answered by that student.  TrackPro will 
also display the student's score for each segment test that has been 
taken. 

(A student may have multiple responses for the same question if he 
repeats a section of the course that contains the question or if he 
encounters the question in different parts of the course, such as the pre- 
or post-tests or quizzes). 

 

View Course Question Performance Facility-Wide 
 
In addition to displaying responses for quiz and segment tests for 
individual students, the administrator also has the ability to generate a 
report showing the overall results for each quiz question in a course for all 
students.  
 

1. Select [TrackPro]  [Database]  [Create Database 
Reports]. 
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2. Select [Course Question Statistics Report]. 

 

3. Click on the  button. 

*See "Reports" for more information on this feature. 

View Student Network Status  
An administrator can quickly determine who is logged onto the 
CourseWorks® system over an entire network. With the "View" utility she 
can also determine what course a student who is logged on is taking. The 
administrator also has the ability to forcibly log out any student who may 
have inadvertently left his computer logged in to CourseWorks®. 

Log Out a Student 
1. Select [TrackPro]  [View]  [View Student Network 

Status]. 
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2. To log out a student, select the student name that is to be 
logged out. 

  

3. Click on the  button. 

Administration Menu 
As a course administrator you will frequently use the TrackPro tools 
featured under the Administration menu. The Administration menu 
displays options for scheduling courses, setting up curricula, deleting 
student data, enrolling students, etc. 
 
These features are explained in detail in their respective sections in this 
documentation. 
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Database Menu 
The TrackPro Database menu is used to perform database functions such 
as importing or exporting student data or accessing other CourseWorks® 
databases. This menu is also used to access the reporting features in 
CourseWorks®. 

 

These features are explained in detail in their respective sections in this 
documentation. 
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Install and Configure Courses 
Overview 
Note: In order to install a CourseWorks® course, the 

CourseWorks® learning management system 
software itself must first be installed. (See "Step 1" in 
the figure below). 

Once you have installed CourseWorks® you can immediately proceed to 
installing individual courses. If CourseWorks® has not yet been installed, 
see "Installing CourseWorks®". 
 
Each time you install a course you must complete a two-step process. 
You… 
 

1. "Install" the course. 

2. "Set up" (configure) the course.  

 

Both steps are accessed via the CourseWorks® "Setup" program. There 
are two alternatives for starting Setup... from the Windows' Taskbar or 
from the Desktop. (There isn't any significant difference between the two 
alternatives, you can use whichever method you prefer). 

 English and foreign language courses are installed and 
configured in the same way. 
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Start Setup from the Desktop 
1. Double-click on the CourseWorks® icon on your desktop. 

 

2. Double-click on "Setup". 

 

Installing a Course 
Note: Courses cannot be properly installed and set up using the 

"Run" command from the "Start" menu on the Windows 
taskbar. They must be installed using the CourseWorks® 
Setup program. 

1. Insert the course CD in the CD-ROM drive of your 
computer. 

2. Select [Programs]  [CourseWorks® v8.0]  [Setup]. 
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3. Click on the  button.  

4. The program displays the "Select course(s) for installation" 
dialog box. 
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5. Select the type of course you want to install. You will 
probably choose "Standard CourseWorks® courses". (The 
second option, "Custom CourseWorks® courses", is used to 
install courses that you may have customized using the 
CourseWorks® Build Lite feature.  See "Build Lite" for more 
information.) 

6. The title of the course CD that you inserted in the CD drive 
will appear in the… "available courses to install at this 
location:" field. 

7. Click on the  button.  

8. Click on the  button. The "Choose installation 
purpose" dialog box displays. 

 

9. Click on the radio button of the installation purpose that you 
want to use, "Playback", "Build" (authoring) or both.  If you 
will be modifying the courses using the CourseWorks® Build 
software you will need to select either the second or third 
radio button. 

10. Click the  button. 

11. The "Select installation destination" screen appears.  
Select either the default location where the course is to be 
installed or a custom location. 
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12. Click the  button.  When the installation process is 
complete the program will take you back to the main Setup 
screen. 

 

13. Click on the  button. 
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WARNING! 

During the time the course is installing, you cannot use 
the Windows' "ALT" + "TAB" command to reach another 
software application. Interrupting a course installation will 
result in only some of the course files being installed, and 
your database will not be updated! 

Configuring a Course 
There are a number of options available to the training administrator when 
she is configuring a course, including setting course navigation 
capabilities, creating pre- and post-tests, allowing students to do things 
such as send emails (CW8 version courses only), and more. 
 
.Start the CourseWorks® Setup Program 

1. Select [CourseWorks® v8.0]  [Setup]. 

 

2. Click on the  button. 

3. Complete the desired dialog box options in the "Course 
Setup screen. 
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*See discussions of options in the next section on "Course 
Setup Options". 

4. Click on the  button to activate your selections. 

Course Setup Options 
Course 
Click on the  button in the "Course Setup" dialog box to display 
a description of the course which is highlighted in the drop down menu. 
This description cannot be edited. 

Print 
Click on the  check box on the "Course Setup" dialog box to enable 
the "Print" feature (only text screens can be printed).  
When enabled, a Print button  displays on the lower left side of the 
screen while the student is taking the course. The student can click on the 
button at any time to print the current text screen. 
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Summary 
Click on the  check box on the "Course Setup" dialog box to 
enable the "Summary" feature.  
 
When enabled, after a student exits a course CourseWorks® will display 
the results of any segment tests that he took during the course.  These 
scores will be shown on the Deliver screen when he exits the course.  

Certificate 
Click on the  check box on the "Course Setup" dialog box to 
enable the "Certificate" feature.  
 
When enabled, upon successful completion of the course CourseWorks® 
will prompt the student to print his own "Certificate of Completion" for that 
course. 
 

Note: There are two methods for producing training 
certificates. One is to select this option in the 
"Course Setup" dialog box so the student is 
prompted to print a certificate upon completion 
of the course himself. Alternatively, the 
administrator can use TrackPro's 
Administration menu to access the "Print 
Certificate" option and print certificates for 
students who have successfully completed 
courses herself. The administrator can also 
modify the style of the certificate, as well as 
some of the information printed on the 
certificate. *See "Printing Certificates by the 
Administrator" for details. 

Reverse 
Click on the  check box on the "Course Setup" dialog box to 
enable the "Reverse" feature. 

When enabled, a  ("Reverse") button will display on the student's 
screen. When clicked, the student will go back to the previous element in 
that portion of the course. 
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Skip Ahead 
Click on the  check box on the "Course Setup" dialog box to 
enable the "Skip Ahead" feature. 
 

When enabled, a  ("Next") button will display on the course's screens. 
When clicked, the student will skip forward to the next element in that 

segment of the course. If "Skip Ahead" has been enabled, but the  
button does not appear on a particular screen, the student may still be 
able to skip forward to the next element in that segment of the course by 
clicking anywhere on the screen. 
 

Note: The student cannot "skip" past the chapter 
tests. Each test must be successfully 
completed before moving to the next chapter. 

Course Timeout  
Enter the number of seconds allowed of inactivity before a course will 
automatically close and log off the student. 

Tests 
Tests are constructed at the course level, and contain a mixture of 
questions drawn from all of the chapters in a course. CourseWorks® 
allows you to set up both "Pre" and "Post-Tests". 
 

1. Click on the  button of the "Course Setup" 
dialog box to set up an Assessment Test or a "Pre"- and/or 
"Post-Test".  

 
2. The program will display the "Exam setup" dialog box. 
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3. The "Pre-Test" and "Post-Test" options are independent of 
one another, so you can set up one, or the other, or both. 

 
 You can have students "test out" of a course 

altogether if they achieve the passing grade set for the 
pretest. If they pass the pretest, the Deliver program 
will ask them if they wish to continue. You should 
notify students prior to them taking the course as to 
whether they should continue to take the course, or 
log out. 

 

In the dialog box, select which test you want to configure. If you are going 
to be using a Pre-Test click the radio button for the type of test you want it 
to be, "Pre-Test"  or "Assessment" (see the "Assessments" section on the 
following pages). Then specify: 
 

1. How many questions will be asked in the test. 

2. What the passing score for the test will be. 
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Specify the Number of Questions 
Click on the number of questions that you want to be asked in the test.  
Click "other" to be prompted for a number between "one" and the number 
of questions available in the test question pool for that course. 
 

Note: Test questions are selected randomly from the 
pool of available test questions each time a 
student takes the test. The number of 
"questions available" shown at the top of the 
dialog box is the total number of questions that 
were included in the test question pool when 
the course was built.  

Establish a Passing Score 
Use this option to specify the "passing" grade on a Pre- or Post- Test. 
 

1. Click on the checkbox under "Passing Score" for the 
desired test.  This will put a checkmark in the box and 
enable the "passing score" box. 

Enter the desired passing score, from 1% to 100%. 

 

2. Click on the  button. 

3. Once you have set your test parameters, a checkmark will 
be automatically placed in the check box next to the 
Tests/Assessments button on the Course Setup screen and 
the test feature will be activated. 

 

Assessments 
CourseWorks® assessment capabilities allow students to "test out" of 
chapters in a course on topics for which they already have adequate 
knowledge. CourseWorks® will then "reconfigure" the course to include 
only the chapters that the student did not test out of.  
 

1. Click on the  button of the "Course Setup" 
dialog box to set up an assessment.  

2. The program will display the "Exam setup" dialog box. 
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3. In the "Pretest or Assessment" box, click on "Assessment". 

4. An "Assessment" box will appear underneath the "Pretest 
or Assessment" box.  

5. In the "Passing Score" box enter the passing score you 
want to set for the groups of questions in the Assessment 
Test. 

6. If you want CourseWorks® to automatically remove the 
chapters of the course that a student "tests out" of check 
the "Enable Auto-skip" box (if you do not check the "auto-
skip" box, the student will be asked if they want to go 
through the chapters in the course that they have tested out 
of, or if they want the chapters to be removed before they 
take the course).  

7. Once a student has completed the Assessment Test, they 
will see a screen letting them know which chapters of the 
course they have "tested out" of. They will then proceed to 
take the course (which may be reconfigured if the student 
has tested out of one or more of the chapters in the course).  

Message (Course Message) 
When enabled, students see a "course" message that has been created 
by the administrator when they begin a course. Many training 
administrators use this option to make an announcement relevant to the 
course. 
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1. Click on the  button on the "Course Setup" dialog 
box to enable the "Course Message" feature. 

 

Enter the text of your course message and click . 

Activate the Course Message by clicking on the checkbox next to 
the  button. 

Record Only Partial Data 
Quizzing and testing in a course can be designed to occur at four different 
times: 
 

• The course designer can include "quiz" questions throughout 
the course. These are not "scored" tests, but result in 
remediation ("re-teaching") if the student answers a question 
incorrectly. 

• Courses are also often designed with "topic tests" at the end 
of major course chapters. These tests must be passed to 
move to the next course chapter. 

• During the setup process, the administrator can establish an 
assessment test, or pre- and post- tests, all of which are 
"scored". 

Enabling the "Record only partial data" option results in only the pre- and 
post- tests and unit "topic test" results being saved. Otherwise, every 
question's response is tracked, including any "quiz" questions that may be 
encountered throughout the course, resulting in larger database file sizes. 
 

1. Click on the  check box on the "Course Setup" 
dialog box to enable this feature. 
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 If your organization does not need to know how the 
quiz questions in courses were answered, you can use 
the "Record only partial data" feature to reduce the 
potential size of your CourseWorks® database. 

Removing ("Deleting") a Course  
If you want to remove a course from the system, you must use the 
CourseWorks® Setup program. Removing the course frees up space on 
the computer's hard drive where the course was installed. The process 
removes all of the course's files but it does not delete the historical 
student training data for that course which has been recorded in the 
database. 
 

1. Select [Setup]  [Course Delete]. 

 

2. Click on the  button. 

The "Remove CourseWorks® courses" dialog box will display. 
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3. Highlight the course to be deleted from the list of courses. 

4. Click on the  button. 

The "Course Uninstall Warning" dialog box will display. 

 

5. Click on the  button to complete the course(s) 
removal. 

6. To delete additional courses, repeat steps 3 through 5. 
(You can also use the Windows "shift-click" option to 
remove more than one course at a time.) 

7. Click on the  button to exit from the "Remove 
CourseWorks® courses" dialog box. 

Note: After a course has been removed, TrackPro will 
still show the course title with a "Circle with a 
Slash" symbol  next to it. This symbol 
indicates that there is still course or curriculum 
data in the database for students who have taken 
the course. 
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Deliver 
Overview 
Students use the "Deliver"( "play") program to take their CourseWorks® 
courses. How the administrator configures the system will directly impact 
what the student sees when he enters Deliver, such as the "Login" dialog 
box, etc.  These options are all discussed in detail in their respective sections 
of this Trainer's Guide. 
 
No matter what functions have been set up by the administrator, the student 
will eventually arrive at a Course Selection ("Tic-Tac-Toe") Menu, at which 
time they will be able to select the course that they want to take. 

Course Selection ("Tic-Tac-Toe") Menu 

 

The Tic-Tac-Toe menu shows up to nine course or curricula buttons at a 
time. When there are more than nine courses installed on the system, the 
scroll bar is used to view the additional buttons. 
 
The student clicks on a course's button to start the course, or if the button 
represents a curriculum to display that curriculum's Tic-Tac-Toe menu.  
 
*See "Curriculum Overview" for details regarding setting up curricula. 
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Start Deliver from the Desktop 

1. Double-click on the CourseWorks® icon on your desktop.  

 

2. Double-click on the "Deliver" icon. 

 

Course Button Border Colors 
Each course and curriculum button has its title listed on or below the button. 
When the login option in Course Setup is set to "Must be pre-enrolled (login 
is required)", or when login is done by curricula, the student is prompted for 
his student ID before the Tic-Tac-Toe menu displays. Under these two login 
options, the background color around the course or curriculum name on the 
bottom of the button reflects the status of that course (or curriculum) for the 
student logging in. 

Red: Indicates that the course is not readily available on 
the CD-ROM drive (for "JustPlay" and "Hybrid" 
installs). The student may simply need to put the 
course CD in the CD-ROM drive when prompted.  

Purple: Indicates that the student hasn't started the course. 

Green: Shows that the student has started the course but 
has not completed it. (*See "Bookmarks" for more 
details). 

Blue: Shows that the student passed the pre-test and may 
not be required to complete the course. 
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Black: Confirms that the student has successfully 
completed the course. 

Orange: Indicates that the button represents a curriculum. 

Closed Captioning 
Another feature in CourseWorks® is "closed captioning". After a student has 
selected a course if the course has been authored with "closed captions" the 
system will offer him the option of having the closed captioning displayed 
whenever video is playing on the screen. This can be helpful if the student 
has any difficulty hearing, if he would like to have additional time to relate to 
what the video is saying (by using closed captioning in conjunction with the 
"Pause" capability) or if he just wants to both see and hear the information at 
the same time. 
 

 

1. Click on the  button to have closed captioning 
displayed. 
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Deliver Function Buttons 
In addition to the buttons showing the courses and curricula that are available 
to the student, the Deliver Tac-Tac-Toe menu also has five "function buttons" 
at the bottom of the screen. These buttons, "main", "back", "play", "exit" and 
"refresh", are described below.  

 

Main 
This button returns the student to the "parent" curriculum from the current 
subcurriculum. This button is active only if the Deliver Tic-Tac-Toe menu is 
comprised of curricula which have subcurricula. 

Back 
This button returns the student to the previous curriculum from a 
subcurriculum. This button is active only if the student is enrolled in 
subcurriculum and has previously accessed one of these subcurriculum from 
the opening Deliver Tic-Tac-Toe menu. 

Play 
This button plays a course directly from the CD-ROM drive. The course does 
not need to be installed or displayed on the Tic-Tac-Toe menu, but the 
course CD must be in the CD-ROM drive. 

Exit 
This button returns the student to the "Select Language" dialog box.  The 
student will then need to click  again to return to the computer's 
Windows' desktop.  
 

Refresh 
The "refresh" button updates the courses and curricula displayed on the Tic-
Tac-Toe menu. If the student computer is networked, and the student clicks 
on the "refresh" button, any changes made by the CourseWorks® 
administrator related to the student's current curriculum will be displayed. 
 
For example, if the administrator added a "Back Safety" course to the 
curriculum that is being displayed on the student's current Tic-Tac-Toe menu, 
then a "Back Safety" course button will show on the Tic-Tac-Toe menu when 
the student clicks on the "refresh" button.  
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Course Navigation Buttons 
When taking a course in Deliver, the student will also have access to several 
other types of buttons, which typically appear at the bottom of the screen. 
Some of these are "navigation" buttons, which are there so that the student 
can move through the course in ways and at times that suit him best (for 
example, allowing the student to watch a video clip again, move forward to 
the next screen, pause, etc.). 
 
Other buttons allow the student to control how the course is presented, by 
turning off the sound, enlarging the picture, etc. Some of these buttons are 
visible only when the student is viewing a particular type of screen, such as a 
screen playing a video segment. These buttons are described below. 

Audio Control   
The Audio Control button turns the audio portion of the course on or off.  
 

  Audio ON       Audio OFF 
 

Pause/Video Control  

The "Pause" button  pauses the video. 
 

Play 
To resume playing the video after it has been paused, the student clicks on 

the Play  button. 
 

Replay  

The "Replay" button  replays the current audio or video segment. 
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Print 

The "Print" button  allows text or graphic screens to be printed. 

Mail 

The "Mail" button  brings up the e-mail application, allowing the student 
to send an e-mail. 
 

Reverse  

The "Reverse"  (also called the "Back Hand") button returns to the 
previous segment in that portion of the course. This option must be 
previously enabled in Course Setup.  
 

Next 

The "Next"  (also called the "Forward Hand") button allows skipping 
forward to the next element in that portion of the course. This option must be 
previously enabled in Course Setup.  

Exit  

The "Exit"  button exits the student from the course and returns him to 
the Tic-Tac-Toe menu. 
 

Help  

The "Help"  button brings up the Trainers Guide. 

 
Bookmarks 
Not all student training sessions will end as a result of the student completing 
a course. There are a number of other reasons that a student may need to 
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terminate their training session before they finish the course they are taking. 
They may run out of time and need to get back to work, they may be paged 
or receive a telephone call, or they may get called away for some other 
reason. 
 
To accommodate these types of situations, CourseWorks® includes an 
automatic "bookmarking" capability. If the student has logged in (so the 
system knows who he is), CourseWorks® will "bookmark" how far he 
progressed in the course if he leaves the course before it is completed. The 
next time the student logs in to the system and selects that course, 
CourseWorks® will display a "Course Status" dialog box, and ask the student 
whether he wants to pick up where he left off ("Continue" the course) or start 
the course over from the beginning ("Restart" the course). If 'Continue' is 
selected, the course will resume at the beginning of the chapter the student 
was in when he ended his previous training session. 

 

Student Database Fields 

Overview 
In order for CourseWorks® to track students' training data, the students must 
be "enrolled" in the CourseWorks® database (this can either be done by the 
administrator prior to the students taking courses or the students can "self-
enroll" when they click on Deliver).  When TrackPro is initially installed there 
are five predefined fields in the database. They may be renamed but not 
deleted.  
 
Three of the fields are "required", two are not. Required fields must be 
supplied with data as each student is enrolled.  
 

"Required"   StudentID 
Last Name 
First Name 

 
"Not Required" Middle Initial 

Department 
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The fields that are initially set to "Not Required" may be changed to 
"Required" by changing the "Is required" status to "Yes". 
 
Ten additional fields may be established in the database. They can be 
designated as "required" fields or not. These fields can subsequently be 
modified or deleted at any time.  

Renaming a Field 
Any field name, including the names for the five predefined fields, may be 
changed.  To rename a student field: 
 

1. Select [TrackPro]  [Database]  [Database Field 
Configuration]. 

 

The "Database Field Configuration" dialog box displays. 

 

2. Right-click on the field to be renamed.  

3. Select [Rename this field]. 

 78 



 

 

TrackPro highlights the field name in "edit mode".  

 

4. Type in the new field name. 

5. Click on the  button. 

Adding a Student Field 
Ten additional student data fields may be established in the database. These 
fields can be subsequently modified or deleted. To add a student field: 
 

1. Select [TrackPro]  [Database]  [Database Field 
Configuration]. 

 

The "Database Field Configuration" dialog box displays. 
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2. Right-click anywhere within the field table (the white box). 
Select [Add a new field]. 

 

TrackPro displays the following dialog box: 

 

3. Type in the new field's name (14 character maximum). 
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4. Use the drop-down menu to select the "Type" of field. 

 

Below is an explanation of the different data types available: 

Data Type Data Description 
TEXT Alphanumeric characters, no special 

characters such as "/" or ">". 
NUMBER Numeric characters only 
YES/NO "Yes" or "No" response only. 
DATE Date-formatted data, such as "date 

of hire" or "birthdate". 
 

5. Click on the  button. 

Deleting a Field 
Database fields may be deleted, except for the five predefined fields. 
However, once you delete a field all of the data that has been stored in that 
field in the database will be deleted for every student and cannot be 
recreated. To delete a field: 
 

1. Select [TrackPro]  [Database]  [Database Field 
Configuration]. 
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2. Right-click on the field to be deleted. Select [Delete this 
field]. 

 

TrackPro displays the following warning: 

 

3. Click on the  button. 

Designating a Field "Required" or "Not Required" 
For fields that have been added, the administrator can designate that field as 
"required" or "not required". To do this: 
 

1. Select [TrackPro]  [Administration]  [Set Login Field 
Requirements]. 
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The "Login Field Requirements" dialog box displays. 

 

2. Right-click on any field whose "Required/Not-required" status 
is to be changed.  This will bring up the "Make this field 
required" checkbox. 

 

 

3. Click . 

Student Database: Adding, Modifying and 
Deleting Students 
You can use TrackPro to manage your organization's student training 
records. You can add or remove students from the database, as well as 
change their demographic data. 
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Adding a Student  
If the administrator has chosen the "Must be Pre-Enrolled (Login is required)" 
option as the enrollment requirement for Deliver (see "Enrollment 
Requirement" for more details), a student's demographic information must be 
entered into the database prior to the student logging in to Deliver.  To do this: 
 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 

 

The "CourseWorks® Enrollment Utility" dialog box displays.  
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2. Click on the "Enrollment by Student" tab and then click on the 

 button.  

TrackPro displays a blank "New Student Registration" dialog 
box.  Two types of fields will appear in this box… the pre-
defined fields that are required by CourseWorks® (Student ID, 
First Name, Last Name, Middle Initial and Department) and 
any other fields that have been set up by the administrator. 
(See "Student Database Fields" for more details.) 
 

 

3. Enter student data in the fields. 

4. Click on the  button to save the new student record. 

Note: TrackPro will display an error message when you 
attempt to register a new student without filling in 
the required fields. 

Modifying Student Data 
The administrator also has the ability to modify a student's data, such as 
make a name change for someone who was recently married, at any time.  To 
do this: 
 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 
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The "CourseWorks® Enrollment Utility" dialog box displays.  

 

2. Click on the "Enrollment by Student" tab and highlight the 
desired student. 
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3. Click on the  button.  

TrackPro displays the current student data. 

 

4. Change the necessary student data in the listed fields. 

5. Click on the  button to save your database changes. 

6. Click on the  button on the Enrollment Utility screen after 
all changes have been made. 

 

7. Click on the  button. 

Deleting a Student from the Student Database 
Note: "Deleting" a student will remove all of the 

student's demographic and historical training 
data. It is strongly recommended that you export 
the student's data as a backup prior to deleting 
them from the database. (See "Exporting a 
Student's Data" for more information.)  
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Delete a Student 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 

 

The "CourseWorks® Enrollment Utility" dialog box displays.  
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2. Click on the "Enrollment by Student" tab and highlight the 
student to be removed from the database. 

 

3. Click on the  button. 

You will be "warned" by a dialog box that the student will be 
deleted from the database and asked to confirm that you really 
want to delete the student. 

 

4. Click on the  button.  
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Curricula  
Curriculum Overview 
As courses are installed, CourseWorks® automatically includes them in a 
group called the "All Courses in the System" curriculum. All of these course 
buttons will be displayed on the Tic-Tac-Toe menu when a student starts 
Deliver unless the administrator configures the login setup differently. (See 
"Login" for details). 
 
The CourseWorks® curriculum feature gives the administrator the means to 
group courses into additional curricula. Organizations can want to group 
courses for varied and different reasons. For instance, an organization may 
want to set up a curriculum so that every entry-level person takes certain 
mandatory courses. After the new hires complete that curriculum, they may 
then be required to take a different group of courses for their particular 
occupation. Another organization may set up curricula for levels within a job 
type, such as Machine Tech I, Machine Tech II, etc. 
 
An additional benefit of using the curriculum feature is that when students log 
in to Deliver they see only the courses in their curriculum. This in a sense 
"filters" the course list for students so that they aren't overwhelmed by seeing 
every course that is installed on the system.  It also keeps them focused on 
only the courses they should be taking. 
 
While many organizations will set up different curricula for various categories 
of workers, the administrator may also include certain courses that are 
"universal" and need to be taken by everyone in each curriculum. 
 

 
 
In this illustration office personnel will take courses "X", "Y", "Z", and "Safety 
for All". Field personnel will take courses "A", "B", "C", "D", and "Safety for 
All". 
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Both curricula have one course in common, the course titled "Safety for All" 
(if there are several courses that are needed by all personnel, the 
administrator should establish a "subcurriculum" containing these courses, 
then include that subcurriculum into every curriculum, rather than include the 
individual courses in every curriculum).  

 

   
In this illustration, the left-hand Tic-Tac-Toe menu is the main CourseWorks® 
Deliver screen. It has seven curricula buttons. If the student clicks on the 
"Warehouse Employees" button, CourseWorks® will then display the courses 
available in the "Warehouse Employees" curriculum menu on the right.  

Subcurriculum Overview 
An administrator can refine the grouping of courses by establishing 
subcurricula. A subcurriculum is a curriculum within a curriculum.  One thing 
that creating subcurricula will do is allow an administrator to define a group of 
courses that needs to be included in multiple curricula. If subcurricula are set 
up, when a student selects a curriculum he will initially see a curriculum Tic-
Tac-Toe menu displaying both buttons for the "subcurricula" in that 
curriculum as well as buttons for any individual courses that are part of that 
curriculum. When he selects a subcurriculum button by clicking on it, the 
student then sees the subcurriculum Tic-Tac-Toe menu displaying the 
courses in that subcurriculum. 

 CourseWorks® is designed to operate either by curricula or by 
individual course, not a combination of both.  If an organization 
sets up curricula, courses should no longer be thought of or 
handled individually, but should always be part of a curriculum, 
even if they are the only course in that curriculum. Enrolling 
students in a curriculum automatically enrolls them in all of the 
courses included in the curriculum. 
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  

In this illustration, the left-hand Tic-Tac-Toe menu is the CourseWorks® 
Deliver screen that appeared after selecting the "Manufacturing" curriculum 
button. It has three individual course buttons and one subcurriculum button. If 
the student clicks on the "Additional Curricula – Basic Safety Courses" 
button, CourseWorks® will then display the courses available in the "Basic 
Safety Courses" subcurriculum in the menu on the right. 

Setting Up and Using Curricula 
The administrator completes several steps in order to set up and use 
curricula properly: 
 

1. Establish and name the curricula. 

2. Designate the courses to be included in each curriculum.  

3. Establish and name any included subcurricula. 

4. Enroll students into curricula (instead of individual courses). 

5. Configure CourseWorks® Deliver to display courses by 
curricula. 

These steps are explained in detail below. 

Creating a Curriculum 
To set up a curriculum and establish how the curriculum will be displayed on 
the Deliver Tic-Tac-Toe menu: 
 

1. Select [TrackPro]  [Administration]  [Curricula Setup] 
 [Create New Curricula]. 
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TrackPro displays the "Add Curriculum" dialog box. 

 

2. Complete the options for the curriculum: 

a. Enter the title for the curriculum. 

b. Choose the background color for the curriculum's Tic-Tac-
Toe menu. 
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c. Choose either a banner bitmap or banner text (depending 
on if you are using a graphic that you have created or 
typing text) for the banner that appears at the top of the 
Deliver Tic-Tac-Toe menu. (This is typically the name of 
the curriculum.) 

3. Click on the "Use banner bitmap" radio button and then the 
"select graphic for banner" button in order to specify a bitmap 
file location to be used for the banner, or click on the "Use 
banner text" radio button and then use the three text buttons to 
specify the banner text options… the text, the font and the 
background color. 

  or   

4. Click on the  button to save the selections that you 
have made, such as: 

          

 Click on the  button at any time to display the results 
of your choices. 

Designating the Curriculum's Courses 
Once a curriculum is set up, the administrator specifies what courses will be 
included in it. 
 

1. Select [TrackPro]  [Administration]  [Curricula Setup] 
 [Modify Curricula]. 
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TrackPro displays the "Modify Curricula Content" dialog box. 
 

2. Select the curriculum that you want to add courses to. 

 

Note: "+" signs on existing curricula indicate that they 
have courses assigned to them. To "expand" 
(show) the curriculum's list of courses click on the 
"+" sign. Click on the "-" symbol to "hide" the list 
of courses in that curriculum. 

3. Click  to show the "Available Course List".  
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4. Select any of the course titles in the "Available Course List" on 
the right side of the screen, and drag the title, using the left 
mouse button, into the desired curriculum. 

 

 
 You may also copy courses listed under one curriculum 

in the "Curricula Content Tree" (left box) to another 
curriculum by dragging via the right mouse button. 

5. Click . 

The "Modify Curriculum Properties" dialog box will display, 
showing your selections. You then have the opportunity to 
change any other curriculum attributes that you would like. 
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6. Click . 

Note: You can modify these settings at any time after 
the curricula is created by clicking on [TrackPro] 
 [Administration]  [Curricula Setup]  
[Modify Curricula]. 

Deleting a Curriculum 
Deleting a curriculum does just that. It removes that curriculum from the 
available list of curricula. It does not remove any courses from the computer. 
(If you need to physically "delete" a course from CourseWorks®, select 
[Setup]  [Delete a course]).   
 
To delete a curriculum: 
 

1. Select [TrackPro]  [Administration]  [Curricula Setup] 
 [Delete Curricula]. 

 

TrackPro displays the "Delete Curricula" dialog box. 
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2. Highlight the curriculum to be removed. 

3. Click on . 

4. Click on . 

Viewing Curricula in Deliver 
Once curricula have been created, you need to configure the Deliver Tic-Tac-
Toe menu to show the various curricula that are available to your students.  

1. Select [TrackPro]  [Administration]  [Set Deliver 
Mode]. 

 

2. The "Deliver Mode" dialog box will be set to "By curricula". 
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3. Click . This sets the Tic-Tac-Toe menu to display the 
buttons for the curricula that you have created. 

The next screen to display will be the "Organization by Curricula" 
screen.  Now that you have configured Deliver to show the curricula 
you have created, you need to choose which curricula you want to be 
available to each of your students.  The two options are:   

• "All of the curricula in the system."  
— With this option, when a student enters Deliver, all of 

the curricula in the system will display on the Tic-Tac-
Toe menu. When the student clicks on his desired 
curriculum he will then be prompted for his login. 
  

• "Only the curriculum in which the student is pre-enrolled." 
— With this option, when a student enters Deliver they will 

be prompted to enter their login first. After the student 
logs in the Tic-Tac-Toe menu displays only curricula 
that he has been pre-enrolled in. 
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4. Choose the option that you want based on the criteria 
described above and click . 

Changing the Order of Courses 
on a Tic-Tac-Toe Menu 
Every curriculum has its own Tic-Tac-Toe menu. The course buttons are 
displayed via the Deliver program. The order of the course buttons is 
determined during the curriculum creation process. As each course is added 
to the curriculum, its button is added to the end of the list of course buttons in 
the curriculum.  

 

The buttons display in the Tic-Tac-Toe menu from left to right and from top to 
bottom. It is easy to rearrange the order of a curriculum's buttons as follows. 
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1. Select [TrackPro]  [Administration]  [Curricula Setup] 

 [Modify Curricula]. 

 

TrackPro displays the "Modify Curricula Content" dialog box.  Choose 
the curricula in which you want to change the order of the courses. 

 

2. Click on .   

3. Highlight a course for which you want to change the location 
of its button. Then, using the left mouse button, drag the 
course title below the title you want it to be displayed after. 
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   

This following illustration shows the new course arrangement on the menu. 
("Bloodborne Pathogens" was moved to the second position on the menu).  
 

Note: Use this method to change the order of courses in 
a subcurriculum as well.  
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Modifying Curricula 
The banner, the border color, and the order of the curriculum buttons are 
determined when the administrator sets up or modifies the curricula.  You 
can modify curricula at any time. 
 

1. Select [TrackPro]  [Administration]  [Curricula Setup] 
 [Modify Curricula]. 

 

TrackPro displays the "Modify Curricula Content" dialog box, with the 
curricula in a "compressed" view (not showing the individual courses in 
each curriculum). 
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2. Highlight the curriculum that you want to modify and click 
. 

 

3. In this screen you can add or delete any courses in that 
curriculum.  When you are finished click on . 

4. You can then change any of the elements in the "Modify 
Curriculum Properties" dialog box that you want to be different. 

 

 104 



 

For instance, a new "text" banner can be set up quickly. Click 
on the "Use banner text" radio button and complete the text 
options:  

 
If you opt for a banner bitmap, you will be prompted to indicate the 
bitmap file's location. This is a file that you will have created previously 
in a graphics software program. All banner bitmaps should be 514 x 52 
pixels. 

 
5. Click on the  button when you are finished. 

Creating Subcurricula 
Subcurricula are used to simplify the grouping of an organization's courses. 
 
For instance, the administrator may determine that there are several courses 
that are needed by all students in all departments. If that is the case, the 
administrator should establish a "subcurriculum" containing those courses 
and then include that subcurriculum into every curriculum, rather than include 
the individual courses into every curriculum. 
 
An administrator can create any number of subcurricula, grouping courses by 
some common criterion. She can then include these subcurricula within the 
relevant curricula. Students assigned to a curriculum are automatically 
enrolled in all of the courses that are included in all of that curriculum's 
subcurricula. 
 
For example, Kathy Johnson in the Manufacturing Department needs to take 
the courses in the "Manufacturing" curriculum.  She also needs to take the 
courses in the "Basic Safety Courses" subcurriculum.  When Kathy accesses 
Deliver and enters her login, she will see the following Tic-Tac-Toe screen, 
which displays both the individual courses in her "Manufacturing" curriculum, 
as well as a button for the "Basic Safety Courses" subcurriculum. 
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If Kathy clicks on the "Additional Curricula – Basic Safety Courses" button, 
she will then be able to view the courses available in that subcurriculum. 
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To Create a Subcurriculum 
Subcurricula are created in the same way that curricula are created (in fact, 
they are curricula that is used as part of another curricula).  To create a 
subcurriculum: 
 

1. Select [TrackPro]  [Administration]  [Curricula Setup] 
 [Modify Curricula]. 

 

TrackPro displays the "Modify Curricula Content" dialog box, with the 
curricula in a "compressed" view (i.e., only showing the curricula names, not 
the courses within each curriculum). 

 

2. Select the curriculum that you want to create a subcurriculum 
for and click . 
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3. In the next screen, right click on the curriculum title and click 
 again. 

 

The "Add Curriculum" screen will appear allowing you to define your 
subcurriculum using the same methods that you previously used to 
define your original curricula. 

 

 

4. Once you have defined your subcurriculum, click . 

To add courses to your subcurriculum, follow the directions in 
"designating a curriculum's courses". 
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Enroll Students 
Overview 
There are two main approaches for enrolling students, "Enrolling by Student" 
and "Enrolling by Course/Curricula". You can either select a student and 
enroll him into courses or curricula, or you can select a course or curriculum 
and then enroll students into that course or curriculum. 
 

 
 

 
 
You can enroll an individual student into one course, multiple courses, a 
single curriculum, or multiple curricula, by using the "Enrollment by Student" 
capability in TrackPro. 
 
You can enroll multiple students into courses or curricula via the "Enrollment 
by Course/Curricula" tab. 
 

Note: The idea of a student being "registered" or 
requiring them to be "pre-enrolled" in a course or 
curricula is a key part of the CourseWorks "Login" 
function. *See "Login Procedures" for details. 

 CourseWorks® has a powerful feature in which the administrator 
can group courses into a "curriculum". If you aren't familiar with 
the curriculum feature, you should review the "Curricula" 
section of this guide. 
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Enrolling an Individual Student (into Courses  
or Curricula) 
Use the "Enrollment by Student" tab to enroll an individual student into 
courses or curricula. 
 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 

 

The "CourseWorks® Enrollment Utility" dialog box displays. 
  

2. Click on the "Enrollment by Student" tab and highlight the 
desired student. 

 

3. Click on the  button. 

CourseWorks® displays the "Student Enrollment" dialog box.  
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The dialog box default is to enroll by course. The "Selected 
Courses" column on the right indicates which courses the student 
is enrolled in. 
 
Note: If the student you have chosen has been 

previously enrolled in courses through curriculum, 
the courses and curricula he is already enrolled in 
will appear in the box at the bottom of the screen. 

 

Note: You can click on the radio button to switch to 
"View by curriculum" to enroll students into 
curriculum. 
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 Can't remember what course titles are in each 
curriculum? Click on the  button to see a list of all 
the curricula and their courses. 

4. In the "Available Curricula" column on the left side, highlight 
the courses (or curricula) in which the student is to be enrolled. 

5. Click on the  button to move the desired courses (or 
curricula) into the "Selected Curricula" column on the right side. 

6. Click on the  button. 

 Select multiple courses or curricula by holding down the 
 key and clicking on the desired courses. Select a 

contiguous group of courses by holding down the  
key and clicking on the topmost and bottommost courses 
in the list. 

Removing a Student from a Course  
(or Curriculum) 
The "Enrollment Utility" dialog box can also be used to remove students from 
courses or curricula. 
 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 
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The "CourseWorks® Enrollment Utility" dialog box displays.  
 

2. Click on the "Enrollment by Student" tab and highlight the 
desired student. 

 

3. Click on the  button. 

CourseWorks® displays the Student Enrollment window. (The 
dialog box's title bar displays the name of the student. In this 
example, the student is "Steven Tyler"). 
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The "Selected Courses" column on the right indicates what courses the 
student is enrolled in.  
 
Note: You can click on the "View by curriculum" radio 

button to remove students from a curriculum, 
rather than a course. 

4. In the "Selected Courses" column, highlight the courses (or 
curricula) from which the student is to be removed. 

5. Click on the  button. 

Note: You are not deleting a course (or curriculum) from 
the computer. You are simply deleting this item 
from the student's "selected list". 

6. Click on the  button. 

Note: After a course or curriculum has been deleted 
from the student's "selected list", TrackPro will 
show the name on the list, but with a "Circle with 

a Slash" symbol  next to it. This symbol 
shows you that there is still course or curriculum 
data about that student's participation in that 
course/curriculum in the database. 
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Enrolling Multiple Students (into Courses and 
Curricula) 
The following procedure is used to enroll multiple students simultaneously 
into courses and curricula. 
 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 

 

The "CourseWorks® Enrollment Utility" dialog box displays.  
 

 

2. Click on the "Enrollment by Course/Curricula" tab. 

 115 



 

 

Note: (Optional Step) Click on the radio button to switch 
to the curriculum view. 

3. Use the "Course (or curriculum) to which students will be 
enrolled" drop-down menu to select the desired course (or 
curriculum). 

4. Select the students that are to be enrolled from the "Available 
Students" column in the left window pane. 

5. Click on the  button to move the highlighted students 
into the "Enrolled Students" column in the right window pane. 

6. Click on the  button. 

 Select multiple items in a list by holding down the  key 
and clicking on each item. Select a contiguous group of 
items by holding down the  key and clicking on the 
topmost and bottommost items. 

 You can enroll students from a specific department by 
clicking on the "Show students by Department" check 
box. 
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Scheduling Courses  
Overview 
TrackPro's "Course Scheduler" feature is used to set up a course schedule 
for each student. The administrator can establish start/end dates for any 
required course or curriculum. With the scheduler she can also set up a 
"recertification" period, which will indicate when the student will be required to 
take a specific course or curriculum again. This is a particularly useful feature 
for ensuring that students meet any certification or regulatory retraining 
requirements that they might have. 
 
Note: A student must be enrolled in a course in order to be 

scheduled for that course. 

Starting the Course Scheduler 
1. To start the Course Scheduler select [TrackPro]  

[Administration]  [Course Scheduler]  [Set Schedule].  
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2. The program displays the scheduler settings window. There 
are three options for scheduling students to take courses: 

a. Schedule by course: 

 

b. Schedule by curriculum: 

 

c. Schedule by department: 

 

WARNING! 

If you have established curricula, do not schedule by course; 
select the radio button option "Schedule by curriculum". 

3. Once you have chosen your desired scheduling method, click 
. 
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4. The scheduler program displays the scheduling window for the 
respective course or curriculum. All students enrolled in the 
course (or curriculum) are listed. 

 

Set Start / End Date 
A "start" and/or "end" date can be set up for each course (or curriculum). This 
can be done using the "Schedule by curriculum" as well as the "Schedule by 
course" options. The "start" date prohibits the student(s) from taking the 
course before the specified date. The "end" date prohibits the student(s) from 
taking the course after the specified date. Setting both a "start" and "end" 
date effectively establishes a window of time during which the student(s) 
must take the course. 
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1. Select the students (or course/curriculum) that you will be 
scheduling. 

Note: This can be done by clicking on each individual 
student (or course/curriculum) or by using the 
"Select all" or "Unselect all" buttons at the bottom 
of the screen. 

 

2. Click on the "Start date" or "End date" radio button. 

 

3. Click on the  button. 

 

4. Select the date by using the month and year drop-down 
menus and by clicking on the desired date in the calendar.  

 

5. Click on the  button. 

The scheduler will display the date on the student's record. 
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The student will not be able to take the course or curriculum until the 
specified date. TrackPro will display a warning if he attempts to do so. 

 

If an "End date" is set and the student attempts to take the course after 
the end date, TrackPro displays a warning indicating that the last date 
that the student could have taken the course/curriculum has passed. 
 

 

To Clear or Change a Date Already Set 
To clear a beginning or ending date that has already been set, simply select 
the student for whom you wish to clear the date.  Then click on the "Start 
date" or "End date" radio button and click on "Clear date".   To set a new date, 
follow the steps in the Set Start/End Date section of this guide. 

Set the Recertification Period 
The recertification period option is used when the administrator needs to set 
up a "retake" period for a course/curriculum the student has taken.  This 
allows the administrator to set a period (in days) of time when the student is 
required to take the specific course (or curriculum) again.  
 

 

1. Click in the "Period (in days)" box and enter the number of 
days within which the student should take the course/ 
curriculum. 

2. Click on the  button. 

The number of days set for the recertification period will be 
displayed on the student's record for that course/ curriculum. 
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(The recertification period is informational and remains on the 
student's record after the period is past). 

 

Viewing Student Course Schedules 
Use TrackPro's "View Schedule" option on the "Course Scheduler" menu to 
view student course or curriculum schedules. 
 

1. Select [TrackPro]  [Administration]  [Course 
Scheduler]  [View Schedule]. 

 

TrackPro displays the "Schedule Choices" dialog box. 
 

 122 



 

 

2. Select a course or curriculum from the drop-down menu. 
(Click on the "View by curriculum" radio button if you intend to 
view the schedules that you have set for a curriculum). 

3. Click on the  button. 

The schedules for the selected course (or curriculum) will display. 
 

 

4. Click on the  button. 
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Viewing and Printing TrackPro's Course Schedule Reports 
TrackPro has several predefined reports with which you can either view or 
print student course schedules. 
 

1. Select [TrackPro]  [Database]  [Create Database 
Reports]. 

 

2. TrackPro will display the list of available reports. Select the 
desired "schedule" report from the report list. 

 

3. Click on the  button.  

The example below illustrates a sample report. 
 

 

*See "Reports" for more details. 
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Selecting the Courses or Curriculum 
for Deliver 

 

 

When CourseWorks® is first installed the "All Courses in the System" 
curriculum is automatically created. When a new course is installed, it 
automatically becomes part of this curriculum.  
 
If the administrator is not going to be establishing additional curricula beyond 
this one system "default", then for the purposes of further discussion, the 
administrator will be organizing their training by course, and students will 
always see a Tic-Tac-Toe menu of all the available courses upon entering 
Deliver. After selecting the course that they want to take, the student may 
then see a login screen and be asked to log in, depending on the course 
login options that the administrator has put in place.  
 
However, if the administrator will be setting up additional curricula, then 
training is considered to be organized by curricula. In this case, the student 
will normally first see a login screen and be asked to log in to CourseWorks®. 
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The curricula that are available for them to take will then be listed in a 
"Curriculum Menu" dialog box. 

 Deciding whether or not to organize training by curricula is 
extremely important, as it impacts just about every aspect of 
CourseWorks® including student logins, course/curricula 
scheduling, and tracking students' progress. The training 
administrator must make this decision before enrolling any 
students into courses or curricula. She should organize the 
training either by courses or by curricula, but not by both. 

Set Deliver Mode 
Designating specifically what courses and/or curricula a student will see on 
the Curriculum Menu or Tic-Tac-Toe menu is actually a two part process. 
First the training administrator determines whether the menu will be 
organized by curricula or individual courses.  The next step is for the 
administrator to determine whether she wants the students to have the ability 
to enroll themselves in courses/curricula, or whether she will pre-enroll 
students into only the courses/curricula that each student needs to take 
(essentially "locking them out" of courses/curricula they don't need to take).  
 
To start this process, the administrator: 
 

1. Selects [TrackPro]  [Administration]  [Set Deliver 
Mode].  

 

The next screen to appear will be the "Deliver Mode" screen.  This 
screen is used to determine whether the student will see individual 
courses or curricula on the Deliver Tic-Tac-Toe menu. 
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2. If no curricula has been established and you want students to see 
individual courses when they enter Deliver, click the "By course" 
radio button and click . The "Organization By Course" 
screen will appear. 

 
 

3. You can then determine what courses the student will see 
when they start Deliver.  

a. The first option, "All of the courses in the system" will allow 
students to view and take all courses in the system. Under 
this option, when the student starts Deliver he will see the 
Tic-Tac-Toe screen with all courses listed. He will not be 
required to log in until after selecting a course, and only if 
the administrator has set up CourseWorks® to require a 
login.  
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b. The second option, "Only the courses in which the student 
is pre-enrolled" will allow the students to see only the 
courses that the administrator has enrolled them in, 
essentially "locking them out" of courses they do not need 
to take.  Under this display option, when the student starts 
Deliver he will be required to log in and enter his Student 
ID before gaining access to any courses. 

4. Once you have made your selection, click . 

5. If you have organized your courses into curricula, select 
[TrackPro]  [Administration]  [Set Deliver Mode]. The 
"Deliver Mode" screen will appear. 

6. Then select the second radio button, "By curricula" and click 
. 

 

7. The "Organization By Curricula" screen will appear, where the 
administrator determines what curricula the student sees when 
he starts Deliver. 
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a. The first option, "All of the curricula in the system" will allow 
the student to view all the curricula that have been 
established.  Under this option, when the student starts 
Deliver he will see the Tic-Tac-Toe screen with all the 
curricula listed.  He will not be required to log in until after 
selecting his desired curricula. 

b. The second option, "Only the curricula in which the student 
is pre-enrolled" will allow the student to see only the 
curricula that the administrator has previously enrolled him 
in, essentially "locking them out" of curricula they do not 
need to take.  Under this option, when the student starts 
Deliver he will be required to log in and enter his Student 
ID before gaining access to any curricula.  

 

8. Once you have made your selection, click . 

 129 



 

Enrollment Requirement 
Overview 
The enrollment requirement is tied closely to the "Deliver mode" that the 
administrator has selected, since until login and enrollment requirements are 
established the specific courses or curricula that are to be displayed are not 
completely defined. The administrator has three main options for configuring 
the login criterion for a course or curriculum: 
 

• No Login Required. 

• Login Required; students can enroll themselves. 

• Login Required; students must be pre-enrolled by the 
administrator. 

No Login Required 
With this option, students will not be required to enter their Student ID and, 
as a result, neither their responses to questions nor their test scores will be 
tracked. Further, the fact that a student even took a course is also not 
tracked. (Without a login and "Student ID", there is no way for CourseWorks® 
to identify the student and track his progress or training results.) 

Login Required (Self-Enrollment Option) 
Under this option, once the student selects the course or curriculum that they 
want they will be required to enter their Student ID before playing the course, 
and as a result their responses to questions and their test scores will be 
tracked.  
 
Students who haven't been entered in the student database can "self 
register". When they click on a course's/curriculum's button in the Tic-Tac-
Toe menu they will be prompted by Deliver to enter their Student ID.  If 
CourseWorks® does not recognize that ID, the student will be prompted to 
complete a "New Student Registration" dialog box, and will then be enrolled 
in that course/curriculum. Their student registration data will also be 
automatically added to the CourseWorks® student database. (*See 
"Database Field Configuration" for further information.) 
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      

Login Required (Must Be Pre-Enrolled) 
Under this login option, the administrator must "authorize" the student to take 
the training, by enrolling them into that course (or curriculum) prior to them 
taking it… i.e., "pre-enrollment". When the student logs in he will be required 
to enter his Student ID, which will be compared to the list of authorized IDs in 
the system. The student's responses to questions and test scores will be 
tracked. If the Student ID is not valid or if he has not been pre-enrolled by the 
administrator, he will receive a message stating that he has not been enrolled 
in that course/curriculum. 
 

 

Which Login Option is Best for My Organization? 
To determine which login option is best for their environment an administrator 
must first decide if they need to know who has taken what courses, and 
whether the tracking of scores and responses to questions is necessary. If 
these things aren't important, then the administrator may opt to keep the login 
default of "No enrollment or login required". 
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If the organization needs to track students who are completing courses, then 
the administrator must decide if it is permissible for students to "self-enroll" 
and take any course/curriculum (in which case the "Open enrollment [login is 
required]" option would be used) or if only students authorized by the 
administrator can take certain courses/curricula (in which case the "Must be 
pre-enrolled [login is required]" option would be used). 
 
If an organization wants to encourage employees to take as many courses as 
possible, the administrator most likely will use either of the first two login 
options. Both of these create an "open access" situation. With either option 
the student can see the available courses/curricula. With the second option 
the student can "self enroll" in the courses if necessary.  
 
These two options also work well in situations where the administrator does 
not have ready access to the computers on which CourseWorks® is installed. 
 
The third login option is often used in situations where time is at a premium 
or there are other reasons that the organization does not want employees to 
take courses that they may not need. With this option the administrator 
retains control over which courses the employee can take, whereas in the 
first two login options the employee decides what course(s) he will take. 
 

 If an organization is using curricula for enrolling students, 
the administrator will need to set the enrollment 
requirement by curricula. 

To Specify a Course's/Curriculum's Enrollment 
Requirement 

1. Select [TrackPro] [Administration] [Enrollment 
Requirement]. 
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The "Set Enrollment Requirement" dialog box displays.  

 

Note: If you have chosen to have the student view 
courses by curricula, the available curricula will 
be listed on this screen instead of individual 
courses.  

2. Select the course/curricula for which you want to establish 
enrollment and click the radio button for your chosen 
enrollment option. 

3. To set the enrollment option for multiple courses/curricula, 
simply repeat steps 1 and 2 above.   

4. Once you have set the enrollment options for all 
courses/curricula that you are working with, click . 

Displaying a Student's Progress at Login 
The administrator can also set up the system to let students see their 
individual progress screen when they log in to Deliver, by enabling "Progress 
Maps". (The "progress" screen lists the course titles and the status of each 
course that the student has started, finished, or has been enrolled in but not 
yet started.)  If "Progress Maps" have been enabled, when the student enters 
his login in Deliver he will see a screen displaying his individual progress.   
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To enable Progress Maps: 
 

1. Select [TrackPro]  [Administration]  [Progress Map]. 

 

2. This feature is set up as a "toggle switch".  To enable the 
feature simply click once on it to put a checkmark next to it.   

 
The following is an example of the type of progress screen that a student 
would then see when he logs in to Deliver: 
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Passwords 
Overview 
CourseWorks® provides two types of passwords: 
 

• Student. 
• TrackPro (Administrator). 

 
Using the "Student" password configures the Deliver environment so that all 
students must provide an individual password when they log in to take a 
course. Among other things, this helps to prevent students from logging on 
as someone else.  The student password is in addition to the Student ID. 
 
The second type of password, the "TrackPro" password, is an administrator 
password that is used to restrict access to the administrative programs in 
CourseWorks®… TrackPro, Setup and Build Lite. Once an administrator 
creates a TrackPro password, she will need it whenever she attempts to start 
up any of these three programs.  

Requiring Passwords When Students Log In 
Using the "Student" password configures the Deliver environment so that all 
students must provide an individual password when they log in to take a 
course. Among other things, this helps to prevent students from logging on 
as someone else (remember, this password must be entered in addition to 
the Student ID). 
 
To require all students to enter a password: 
 

1. Select [TrackPro]  [Administration]  [System 
Password Setup]. 
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The "System Passwords" dialog box will appear. 

 

2. Click on the "If this option is enabled, all students will be 
required to enter their unique password…" check box. 

  

3. Click on the  button.  

All students will now be prompted for their password when 
they log in to Deliver. 

Creating a Student Password 
The first time a student logs in after the "password" feature has been 
enabled, he will be prompted by a password dialog box to supply a password 
and retype it for verification.  

 

Note: Passwords are "case sensitive" and can be no more 
than 12 characters in length. 
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Deleting a Student Password 
Should the student forget his password, the administrator can delete it. This 
is the only way to address the situation since the administrator cannot view or 
modify student passwords. To delete a student password: 
 

1. Select [TrackPro]  [Administration]  [Pre-Enroll 
Students]. 

 

The "CourseWorks® Enrollment Utility" dialog box displays.  

 

2. Click on the "Enrollment by Student" tab and highlight the 
desired student. 

3. Click on the  button. 
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The "Update Student Information" dialog box displays. 

 

4. Click on the  button. The button disappears. 

5. Click on the  button to save your changes. 

The next time the student logs in he will be prompted by the password dialog 
box to supply a new password and retype it for verification. 

Modifying a Student Password 
You cannot modify a student password! There isn't any way for the 
administrator to reveal the student's password. If the student can't remember 
his password, the administrator needs to follow the directions in "Deleting a 
Student Password". Then, the next time the student logs in to a course, he 
will be prompted to create a new password. 

TrackPro (Administrator) Password 
Using the "TrackPro" password restricts access to the administrative 
programs in the TrackPro, Setup and Build Lite sections of CourseWorks®. 
This prevents students from accessing another student's data or modifying 
any of the CourseWorks® settings. This password can only be up to 12 
characters in length.  To create an administrator (TrackPro) password: 
 

1. Select [TrackPro]  [Administration]  [System 
Password Setup]. 
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The "System Passwords" dialog box displays 

 

2. Click on the  button. 

The "TrackPro Password" dialog box displays.  
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3. Type the desired password twice, once in each field. 

Note: Passwords are "case sensitive" and can be no 
more than 12 characters in length. 

4. Click on the  button. 

Remove the TrackPro Password 
Follow the directions for creating the TrackPro password, but when prompted 
with the "TrackPro Password" dialog box, leave both password fields empty, 
then click . 
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Reports 
Overview 
TrackPro provides a powerful, but easy-to-use reporting tool with many 
reports preformatted and ready to go. These predefined reports provide you 
with a quick way to view data regarding courses, students, tests and even 
individual test questions.  
 
The reporting tool also provides you, as the training administrator, with the 
means to create new customized reports by using an existing report as a 
"template" or starting point.  
 
You can also export the report data from CourseWorks® reports to other 
programs and then use these programs to design custom reports. To do this 
TrackPro saves the data in the report into a text file, which is imported into a 
word processing document or a spreadsheet (such as Excel). You can then 
use that program to create a report using the data. The TrackPro reporting 
tool can also be used to export data from the CourseWorks® database into a 
non-CourseWorks® database such as a corporate personnel database, as 
well.  

Accessing and Printing Data Using the 
Report Feature 
TrackPro allows you to view and print a variety of reports, such as which 
students still need to complete courses, a list of students' test scores, etc.  To 
view and/or print these reports: 
 

1. Select [TrackPro]  [Database]  [Create Database 
Reports]. 
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The "Report list" displays the list of available reports. 

 

The list will include both standard and "custom" reports (those 
that an administrator has created by modifying one of the 
standard TrackPro reports). 
 

2. Highlight the desired report. 

 

 Once you have selected a report you can click on the 
 button to see a description of the data and the 

fields that are listed. 
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3. Click on the  button. The program displays the 
report. 

 

4. Select [File]  [Print] to print the report. 

 Use the "File" menu's "Save As Text" option to save the 
report as a text file in the ASCII format. This file can then 
be treated as any standard text file, and can be imported 
into other programs such as Excel or Word. This option 
can also be used to import student performance data into 
a non-CourseWorks® database. 

 You can also use programs such as Excel or Word to 
manipulate the columns in the exported report, such as 
making them wider or narrower, or changing the order in 
which the columns appear. 

Creating a New Report 
To design your own custom report, select the standard report that most 
resembles the report that you want. The original report will serve as a 
template for the new report. The TrackPro report program will guide you 
through a series of dialog boxes in which you will indicate what fields to 
include, what fields to sort the data by, what you want to name the new 
report, how you want to describe the report, etc. 
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To create a new report: 
 

1. Select [TrackPro]  [Database]  [Create Database 
Reports]. 

 

The "Report list" displays the list of available reports. 

 

2. Highlight the report that you want to use as a template/starting 
point for your new report. 
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3. Click on the  button.  

The "Field list" dialog box will display. 

 
4. In the "Field list" dialog box, select the fields currently in the 

report (displayed in the right window pane) that you want to 
include in the new report. Use the  or  buttons to move 
the fields from one window pane to the other. 

Note: The order in which you select the fields 
determines the order in which they appear in the 
report.  To change the order of the fields, simply 
deselect all the fields that you have put into the 
custom report, then reselect them in the desired 
order. 

5. Click on the  button. 

The program displays the "Report fields for template report" 
dialog box. 
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6. To indicate how each field is to be sorted, select the field 
individually and choose "No sort", "Ascending" or "Descending" 
from the "Field sorting" box. 

You can limit what data is included in the report by setting field conditions.  
 

7. With the field still highlighted, click on the "Set field condition" 
button. 

The "Condition for field (fieldname)" dialog box displays possible 
conditions that are relevant to the selected field. 

 

8. Click on the condition that you want to invoke. 

9. Then click . 

If you want to set conditions for additional fields repeat steps 7 and 8 
above. 
 

10. Click on the  button to bring up the "Report name and 
description" dialog box. 

11. To create a title and description for the new report, enter what 
you want to be displayed into those respective boxes on the 
screen. 
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12. Click on the  button. 

Deleting or Modifying a Custom Report 
You may delete or modify any of your custom reports. 
  

1. Select [TrackPro]  [Database]  [Create Database 
Reports]. 
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The "Report list" displays the list of available reports. 

 

Note: The list will include both standard reports and any 
"custom" reports that have been created. 

2. Select the desired report, then click on the  or  
button as desired. 

If you select "Modify", you will be prompted through the same 
series of screens that were used in the report creation process. 

Export a Report to a Text (.txt) File 
The report feature can also be used to export data from a report to a text file, 
which can be imported into another database (such as a corporate personnel 
database) or a spreadsheet (such as Excel).  You can use the other 
database or spreadsheet to manipulate the columns, sorts, etc. in the report 
if you wish.  
 
To export the report data you need to first generate a report that includes all 
of the student performance data and fields of information that you need, then 
select [File]  [Save As Text] from the pull-down menu on the report 
screen. 
 
Follow the directions provided by the other software to import your data into 
those programs. 
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Student Certificates 
CourseWorks® allows "course Certificates of Completion" to be printed under 
two circumstances. Certificates can be printed for students who have 
successfully completed a course, or for students who have successfully 
"tested out" (by passing the pre-test) of a course and do not have to take that 
course. 
 
There are two methods for producing these certificates. The system can be 
set up to prompt students to print the certificates themselves when they 
complete a course, or the administrator can print the certificates at some 
point after the students complete their courses.   

Setting Up a Course to Print Certificates 
Immediately Upon Course Completion 
The administrator can specify that CourseWorks® can print the Certificate of 
Completion immediately after a student completes the course by working in 
the "Course Setup" dialog box. When the "Certificate" feature is enabled, 
students are prompted to print out their own certificate at the completion of 
the course.  
 
To enable immediate certificate generation: 
 

1. Select [Setup]  [Course Setup]. 
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2. Select the course from the  drop-down menu. 

 

3. Click on the  check box to enable the feature. The 
student's "Certificate of Completion" for the course will look like 
this: 

 

Modifying and Printing Certificates by the 
Administrator 
Certificates of Completion can be printed by the administrator for students 
who have successfully passed the courses they have taken or who have 
successfully "tested out" of courses by passing the pre-test that the 
administrator has set up.  
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You can use TrackPro's "Administration" menu to access the "Print Student 
Certificates" option.  This feature allows you to not only print certificates for 
selected students but to also modify the appearance of the certificate as well. 
You can make modifications such as specifying a particular border or style of 
certificate, creating one or two signature spaces with titles, including or 
excluding post-test scores and changing the printer orientation (to portrait or 
landscape).  
 

1. Select [TrackPro]  [Administration]  [Print Student 
Certificates]. 

 

The "Print Certificates" dialog box displays. 

 

2. Complete the "Print Certificates" dialog box to choose the 
students for which you want to generate a certificate. Use the 
drop-down menus to select the students by site, course, and/or 
department.  
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3. Click on the  button to modify the appearance of the 
certificate. 

 

4. Indicate the options you want to use. 

5. Click on the  button to see how the finished certificate 
will look. 

6. Click on the  button when you are ready to print. The 
student's "Certificate of Completion" for the course will look 
similar to this example, depending on the configuration options 
you have selected. 

 

 152 



 

Database "Advanced" Features 

TrackPro has many features that will help to manage your training database, 
such as the ability to merge multiple databases into one, export training data 
for a specific student, remove old training data, etc. 

Removing Obsolete Data from the Database 
Use this procedure if you need to remove specific course histories from a 
student's data. 
 

Note: If you need to completely remove a student and 
all their training records from the database, see 
"Deleting a Student from the Student Database". 

Remove Historical Training Data 
1. Select [TrackPro]  [Administration]  [Delete Student 

Data]. 

 

The "Remove old session information from the database" dialog 
box displays. 
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2. Choose the CourseWorks® database (site) and course for 
which you want to delete student data. 

 

3. If you want to delete all the data prior to a specific date (for 
instance, the previous training year) utilize the "Display all 
entries prior to specific END date" box. This feature will narrow 
down the student sessions shown in the right hand box to only 
those before the date you have chosen. 

 

4. Select the student name(s).  

 You may be able to limit the student list by clicking on the 
"Select by Department" check box and then selecting a 
department from the drop-down menu. 

     

5. After you have selected the student(s) whose data you want to 
delete, click on the  button.  

The program will display a warning message.  
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6. Click on the  button to continue with the purge.  

WARNING 

Be sure this is what you want to do, as this deletion is 
permanent and the data is not recoverable! 

Compacting the Database 
This feature is only applicable to users of CourseWorks® who are using 
an Access-based database. If you have installed the SQL Server 
software to use that version of the database, you do not have the ability 
to compact your database. 

 You can tell what type of database you are working with 
by looking at the title bar of most major TrackPro screens.  

 

If you are running CourseWorks® using an Access-based database, it is 
highly recommended that you use the "Compact Database" feature regularly, 
to free up some of the computer's hard drive space and improve the 
performance and speed of the database. Compacting the database has no 
negative effects and does not affect the data in any way. 
 

 Compact your Access database on a regular basis (this 
should be done at a time when no one else is using any of 
the CourseWorks® applications).  

 
WARNING! 

Failure to compact your database on a regular basis can 
cause performance problems in the CourseWorks® system, 
including data corruption and "database bloating"! 
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To compact the database: 
 

1. Select [TrackPro]  [Database]  [Compact Database]. 

 

The system then compacts the database. You will see the 
Windows hourglass "wait" symbol while the compacting occurs. 
(Depending on the size of your database, this may take several 
minutes to complete.) 

Exporting A Single Student's Data 
CourseWorks® has the ability to export training data for a single student to a 
separate CourseWorks® database.  This data can then be imported into 
another CourseWorks® database.  For instance, if you have a student who is 
taking courses at a remote location, once they have completed their training 
you can export their individual training data to a CD or network drive.  You 
can then access this data and merge it into the main CourseWorks® 
database. 
 
(This function can only be used to merge data from one CourseWorks® 
database to another CourseWorks® database. You cannot use this feature to 
export data to a non-CourseWorks® database. If you want to export data from 
the CourseWorks® database into a non-CourseWorks® database, you must 
first generate a report that includes all of the student's performance data and 
fields of information that you need, then use the "Copy" icon on the toolbar or 
the [File][Save As] command. *See "Copying Report Data to Other 
Programs" and "Accessing and Printing Data Using the Report Feature" for 
more details.) 
 
To export data for a specific student, select [TrackPro]  [Database]  
[Export Student Data]. 
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2. The program displays the "Export student data" dialog box. 

 

3. Use the drop-down menu to select the name of the student 
whose data you wish to export. 

4. Click on the  button. 

A new window will appear notifying you that the exported data 
is saved in a database file located at c:\CrsWrks8\db\StExport. 
 

 

This file can now be imported into a database at another 
CourseWorks® site. To do so, complete the steps for "Merging 
a CourseWorks® Database". 

Merging a CourseWorks® Database 
This process is used when an administrator needs to merge student 
databases from several sites or when a student has taken courses at one 
site, his data has been exported, and the data now needs to be included in a 
different site's database. 
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Note: CourseWorks® files have the extension "mdb", 

"accdb" or "mdf" depending on whether you are 
using one of the Access-based databases or the 
SQL Server-based database. If you merge an 
Access-based database into a SQL Server-based 
database, CourseWorks® will automatically 
convert the Access-based database to SQL 
Server. 

To merge CourseWorks® databases: 

1. Select [TrackPro]  [Database]  [Merge CourseWorks 
Databases]. 

 

The "Merging CourseWorks® Databases" dialog box displays. 
  

 

2. Click on the  button. 
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The "Open" dialog box displays. 

 

3. Select the location where the CourseWorks® file is stored. If 
you have previously exported a student's data using 
CourseWorks®, select the name that you gave the file when 
you exported it (for example "*.accdb").  

4. Click on the  button. 

The "Merging CourseWorks® Databases" dialog box displays.  

 

Note: You can choose to fully merge all of the exported 
data in with your existing data, or to maintain a 
separate site identity for the exported data (i.e., if 
you have separate databases for different 
departments or faculties within your organization) 
by choosing the appropriate radio button on the 
screen. 
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5. Click on the  button. If you need to merge additional 
files, repeat steps 2 through 4. 

Importing a Non-CourseWorks® Database 
This feature is typically used when an organization has student data in an 
existing database or spreadsheet, such as a human resources database, and 
the training administrator wants to import this student information into the 
CourseWorks® database. Student demographic data such as name, 
department, Student ID, etc. can be easily copied via this feature. This can 
save considerable time by not having to re-enter this data into 
CourseWorks®.  Only students' demographic data can be imported into 
CourseWorks®. You cannot import existing training data, such as test results 
and the like, from another database or a spreadsheet.  
 

Note: The database to be imported must first be 
converted or saved to a comma delimited text file 
(".csv") format. Only comma delimited text files 
can be imported into CourseWorks®. 

1. Select [TrackPro]  [Database]  [Import non-
CourseWorks Database]. 
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The "Select ODBC Driver" dialog box displays. 

 

2. Indicate the desired text driver (*.txt or *.csv) and click on the 
 button. (File types other than comma delimited files are 

not supported by CourseWorks®).  

The "ODBC Text Setup" dialog box displays. 

 

3. On this screen, click the "Use Current Directory" checkbox to 
remove the checkmark and enable the "Select Directory" 
option. 

 

4. Click on the  button. 

5. In the "Select Directory" dialog box choose the location of the 
source file that you want to import. 

 161 



 

 

6. Click on the  button. 

7. The next box to appear is the "Import to student database…" 
dialog box.  Here you will need to "map" the fields from your 
source file to the fields in the CourseWorks® database.   

8. In the "Columns in Student Database" box (which represents 
the CourseWorks® database), highlight the field that 
corresponds to the highlighted field in the "Columns in" box 
(which represents the fields in your source file), then click 

. 

 

9. Continue this process until you have mapped all of the fields 
that you want to import. Once all the fields have been mapped 
(and are listed in the "Mapped Fields" box) click on the  
button to begin the merging process (this may take several 
minutes, depending on the size of the file being imported). 

10. Once the file has been imported, CourseWorks® will return to 
the main TrackPro screen where the student information that 
you have just imported will appear. 
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Move Database 
Use this command to physically move the CourseWorks® database to 
another location.   
 

1. Select [TrackPro]  [Database]  [Move Database]. 

 

TrackPro displays the "Save As" dialog box.  
 

 

2. Select the new location ("Save in:" field) and/or filename 
where you want the new database to reside from the 
location/names displayed in the "Save As" dialog box. (The 
default location for the student database is the "db" folder, 
which is a subfolder in "CrsWrks8", the "root" CourseWorks® 
installation folder. Use the "Save in:" box drop-down menu to 
specify a different location).  

3. Click on the  button. 
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Delete Site 
This function is only enabled if your database contains multiple sites.  You 
can use this command to remove data for a particular site from your 
database.  
 

WARNING! 

ALL of the data for the selected site will be deleted and is not 
recoverable. 

1. Select [TrackPro]  [Database]  [Delete Site]. 

 

2. The "Delete a site" dialog box displays. 

 

3. Click on the drop-down menu to the right of the site name 
display to select a different site, if necessary. 

4. Select the site that will be deleted from the database and click 
on the  button. 
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5. A "TrackPro Warning" dialog box will appear, reminding you 
that ALL of the data for the site will be deleted and is not 
recoverable. 

 

6. Click on the  button to delete the site's information. 

Note: If you want to save this site's information for 
future reference, back up the site database first! 
*See "Backing Up the CourseWorks® Database 
(Save)" for more details. 

Restoring from a Backup File 
If you have a need to restore your database from a backup, it is 
recommended that you call the distributor from whom you purchased 
CourseWorks® or MARCOM's technical support department for assistance 
prior to restoring the file. 
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Build8 Lite 
Overview 
As a trainer, you are committed to providing your students with courses that 
give them all of the information they need. Generally, the CourseWorks® 
courses that you have purchased will contain the information that you want 
your students to have about that topic. But in some cases you may want to 
add information that is unique to your organization or site, or remove material 
that is not important to your students. You may also want to ask questions 
within a course about material that you add. 
 
Build8 Lite is the perfect tool if you need to make some quick, straightforward 
modifications to an existing course. With CourseWorks® Build8 Lite, you can 
easily insert or delete information into the course. You can include video 
segments, text, graphics or questions to convey information that is pertinent 
to your organization's operations. You also have the option to include audio. 
You can delete video, text, graphics or questions which are not relevant to 
your students' needs as well.  
 
You can save your customized course and install it on your computers just as 
you would any other CourseWorks® course. 
 

WARNING! 

Customizing a course does not alter its copyright protection. 
The course still belongs to its original authors. If you want to 
make copies of a customized course, you must license that 
right from the course publisher. 

Opening Build 
To open Build, click on the Build icon.  
 

 
 
Once Build is launched, the "CourseWorks 8 Build Course Titles" is the first 
screen that appears. This dialog box displays all of the CourseWorks courses 
that are installed on the system and are available for customizing (if Build 
does not detect any installed CourseWorks courses, this box will be empty.) 

 166 



 

Once you click on the course you wish to customize, the Build8 title bar 
displays the words "CourseWorks Build LITE 8.0": 
 

 

Modifying the Course Metadata 
After a course has been made, any of the information can be changed, such 
as the name or the background. This can be done under the Course Metadata 
found on the modify menu. To change the course information, click Modify > 
Course Metadata. 
 

 
 

This brings up the "Modify Course Metadata" dialog box. This is the same 
screen that was used to create the course.  
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All the course information on this screen can be changed at a later time if 
necessary. 
 
Note: The "View in Deliver" button (next to the course title field) 

will open a preview of what the course will look like in the 
CourseWorks Deliver main menu.  Clicking on the course's 
Tic-Tac-Toe button in the Deliver preview mode will display 
a preview of the course information screen as an end user 
would see it. 

The author also has the option to rename the course by right clicking on the 
title node and selecting "Retitle this course". This option allows the author to 
change the course title (the course ID, which is in parenthesis following the 
title, cannot be changed from this dialog box).   
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The "Course Title Change" dialog box will appear. 

Creating A Segment 
A segment is a single screen in a course. It can be a question, text, a slide or 
a video clip. All segments get created one at a time before the course can 
start to be assembled. 
 
There are two different ways to create a new segment: 
 

1. From the main menu, click Create > Segment and choose the type of 
segment that you want to create. 

 

2. You can also right-click on the segment node (for example, to create a 
video segment, right-click Video Segments > CREATE new video 
segment).   

 

There are four types of segments that can be created…Questions, Text, 
Slides and Videos. Different information must be entered or options selected 
for each of these segment types before they can be created. 
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Video Segments 
Video segments are created using mp4 video files and have optional 
closed captioning (the "closed caption question" needs to be 
inserted in the course in order to play closed captioning. *For more 
information on closed captions, see point #3 below). 

 

1. To create a video segment, click Create > Segment > Video. 

 

The "Create New Video Segment" dialog box will appear. 
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a. A video ID must be entered that will uniquely identify this 
segment. 

b. The location of an mp4 video file must be specified.  Once 
the file has been selected, the length of the video file (in 
seconds) will be displayed in the "selected video length" 
window as an aid to the author. 

2. Closed captions can be inserted into the current video 
segment and appear underneath of the video when closed 
captioning is enabled by the end-user via the closed caption 
question. (See point #3 below).  
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a. The insertion point is based on the closed caption time 
code, which is indicated by a numeric value (in seconds), 
followed by the '::' delimiter.  

 
3. To insert a closed caption, right-click on the Video segment 

node > INSERT closed caption. 

 

4.  The 'Closed Captioning' dialog box will appear. 

   

 172 



 

a. The "Enter Timecode" edit box contains the current 
position of the video (in seconds).  This value can be edited 
to adjust the start time of the closed captioning segment. 

b. The "Set to current video timecode" button copies the 
current video timecode from the timecode display in the 
playback area to the "Enter Timecode" area in the Closed 
Captioning dialog. 

c. The "Enter Closed Caption Text" edit box is where the text 
content is added for the closed captioning.   

Note: To enter a pause in the captioning, leave the 
content box empty. 

d. The "video segment length" box displays the length of the 
video segment (in seconds).  This is an authoring aid and 
cannot be edited. 

e. The  and  buttons are used to navigate between 
existing closed captions.  They will also save the changes 
made to closed captions when you use them to navigate to 
a different caption. 

5. To modify an existing closed caption, right-click on the closed 
caption node > MODIFY this CC. 

 
 
The "Closed Captioning" dialog box will appear. 
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a. The "Enter Timecode" edit box contains the current 
position of the video (in seconds).  This value can be edited 
to adjust the start time of the closed captioning segment. 

b. The "Set to current video timecode" button copies the 
current video timecode from the timecode display in the 
playback area to the "Enter Timecode" area in the Closed 
Captioning dialog. 

c. The "Enter Closed Caption Text" edit box is where the text 
content is added for the closed captioning. 

d. The "video segment length" box displays the length of the 
video segment (in seconds).  This is an authoring aid and 
cannot be edited. 

e. The  and  buttons are used to navigate between 
existing closed captions.  They will also save the changes 
made to closed captions when you use them to navigate to 
a different caption. 

6. When testing a closed caption the author has the option to 
play from a specific closed caption. To do this, right click on the 
desired closed caption > PLAY from this CC. 
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7. To delete a closed caption, right click on the desired closed 
caption > DELETE this CC. 

 
 

 
 

   

 
 

Slide Segments 
Slide Segments are created using jpg graphic files. An audio file 
(mp3) can be associated with a Slide Segment but is not required.  
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To create a slide segment, click on Create > Segment > Slide. 
 

 

The "Create New Slide Segment" dialog box will appear: 
 

 
 

a. A "Slide Segment ID" must be entered that will uniquely 
identify this segment. 

b. The location of a jpg graphic file must be entered into the 
"Browse for Content File" field. 

c. An optional "Segment Timeout" value may be specified (in 
seconds).  If a non-zero number is specified, this segment 
will automatically move on to the next segment after the 
indicated time. 

d. The location of an optional mp3 audio file may be specified 
by entering it into the "Audio File" field  Once the file has 
been selected, the time length of the audio file will be 
displayed in the 'selected audio length' window as an aid to 
the author. 

 176 



 

Text Segments 
Text Segments are segments that consist of text only. They can be created by 
manually entering the text directly in the window or by inserting HTML 
document files.  

 

1. To create a text segment, click on Create > Segment > Text. 

 

The "Create New Text Segment" dialog box will appear: 
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a. A "Text Segment ID" must be entered that will uniquely 
identify this segment. 

b. If "Browse for Content File" is selected, the location of an 
HTML document file must be specified: 

c. If "Enter Text Content" is selected instead, text can be 
typed directly into the window.  Clicking the "HTML" button 
will display the "Font" dialog where the various font 
attributes can be set for the text: 
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d. An optional "Segment Timeout" value may be specified (in 
seconds).  If a non-zero number is specified, this segment 
will automatically move on to the next segment after the 
indicated time. 

e. The location of an optional mp3 audio file may be specified 
by entering it into the "Audio File" field.  Once the file has 
been selected, the time length of the audio file will be 
displayed in the 'selected audio length' window as an aid to 
the author. 

Question Segments 
There are six different types of questions that can be created under the 
"Question Segment" option. Each question type has its own characteristics 
(as described below) and associated correct and incorrect answers.  
 
To create a new question segment, click on Create > Segment > Question. 
 

 
 

1. Text questions are questions that appears to a viewer as 
text. The left-hand side of the screen and accommodate up to 
six answer buttons. 
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a. To create a text question, click on Create > Segment > 
Question > Text. 

 

The "Create New Text Question" dialog box will appear. 

 
 

i. A "Text Question Segment ID" must be entered 
that will uniquely identify this segment. 

ii. Select a module ID from the "Associated Module 
ID" list box. As described in the Trainer's Guide, 
"assessment testing" allows a student to "test out" 
of modules in a course on topics for which they 
already have adequate knowledge. By selecting 
an "Associated Module ID", this question will be 
connected to a particular chapter in the course 
(i.e., a module) in order to facilitate assessment 
testing.  

 180 



 

iii. If "Browse for Content File" is selected, the 
location of an HTML document file must be 
specified: 

 

iv. Create up to six response buttons by entering the 
button labels in the fields on the right side of the 
dialog box (i.e. True/False or A,B,C,D,E,F). 

v. The location of an optional.mp3 audio file may be 
specified by entering it in the "Audio File" field.  
Once the file has been selected, the length of the 
audio file will be displayed in the "selected audio 
length" window (in seconds) as an aid to the 
author. 

2. Graphic questions display a picture with up to six buttons 
along the side. 
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a. To create a graphics question, click Create > Segments > 
Question > Graphics. 

 

The "Create New Graphic Question" dialog box will appear. 

 

i. A "Graphic Question ID" must be entered that will 
uniquely identify this segment. 

ii. Select a module ID from the "Associated Module 
ID" list-box to support assessment testing.   

iii. The location of a jpg graphic file must be 
specified in the "Browse for Content File" field. 

iv. Create up to six response buttons by entering the 
button labels in the fields on the right side of the 
dialog box. 
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v. The location of an optional.mp3 audio file may be 
specified by entering it in the "Audio File" field.  
Once the file has been selected, the time length 
of the audio file will be displayed in the 'selected 
audio length' window as an aid to the author. 

3. Menu questions are review menus that have buttons to allow 
the end-user to repeat previous sections. Review menus can 
have up to eight buttons. 

 

a. To create a menu question, click Create > Segment > 
Question > menu. 

 
 

The "Create New Menu Question" dialog box will appear. 
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i. A "Menu Question Segment ID" must be entered 
that will uniquely identify this segment. 

ii. A menu caption may be optionally typed into the 
"Enter menu caption" field.  Clicking the "HTML" 
button will display the "Font" dialog where the 
various font attributes can be set for the caption. 

iii. The location of an optional.mp3 audio file may be 
specified by entering it into the "Audio File" field.  
Once the file has been selected, the time length 
of the audio file will be displayed in the 'selected 
audio length' window as an aid to the author. 

4. Hotspot questions consist of a graphic where the end-user 
must click on one or more areas of the graphic to indicate the 
correct response. 
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a. To create a hotspot question, click Create > Segment > 
Question > Hotspot. 

 
 

The "Create New Hotspot Question" dialog box will appear. 

 

i. A "Hotspot Question Segment ID" must be 
entered that will uniquely identify this segment. 

ii. Select a module ID from the "Associated Module 
ID" list-box to support assessment testing.  
*Assessment testing is described in the "Question 
Segment" section on page 29. 

iii. If "Hotspot Display" is checked, the end-user will 
see a rectangular border around all hotspot 
areas. 
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iv. The location of a jpg graphic file must be 
specified in the "Browse for Content File" field. 

v. The location of an optional.mp3 audio file may be 
specified by entering it into the "Audio File" field.  
Once the file has been selected, the time length 
of the audio file will be displayed in the 'selected 
audio length' window as an aid to the author. 

b. A hotspot is an area on the image that provides feedback 
when clicked on by the end-user.  Up to twelve hotspot 
areas are allowed per hotspot question:  

c. To create a hotspot area, right-click on the question node 
> CREATE a new hotspot area. 

 

d. Clicking on this option puts the playback engine into editing 
mode, indicated by the 'INPUT MODE' display: 

 

e. While holding the left mouse button down at a position on 
the image on the right side of Build8, move the mouse over 
an area that is to be designated a hotspot area.  A red 
rectangular border with a red label will be drawn to provide 
feedback to the author: 
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f. A hotspot area is automatically labeled HSx_HS with a red 
border on the right side of the Build8 screen and a new 
button node labeled HSx is added to the SEGMENT 
BUILDER tree on the left side of the screen (where 'x' 
represents the hotspot number). 

5. Multiple/Multiple Choice questions present a graphic 
question where the end-user must click on multiple areas of the 
graphic to indicate the correct response. 
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a. To create a multiple/multiple choice question, click on 
Create > Segment > Question > Multiple/multiple 
choice. 

 

The "Create New Multiple/Multiple Choice Question" dialog box will 
appear.  

 

i. A "Multiple/Multiple Choice Question Segment ID" 
must be entered that will uniquely identify this 
segment. 

ii. Select a module ID from the "Associated Module 
ID" list-box to support assessment testing.  
*Assessment testing is described in the section 
on "Question Segments" on page 29. 

iii. If "Hotspot Display" is checked, the end-user will 
see a rectangular border around all hotspot 
areas. 

iv. The location of a jpg graphic file must be 
specified in the "Browse for Content File" field. 
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v. The location of an optional mp3 audio file may be 
specified in the "Audio File" field.  Once the file 
has been selected, the length of the audio file will 
be displayed in the "selected audio length" 
window (in seconds) as an aid to the author. 

A "hotspot" is an area on an image that provides feedback when it is 
clicked on by the end-user.  Up to twelve hotspot areas are permitted 
per multiple/multiple choice question or sequential/multiple choice 
question.   

a. To create a new hotspot area, right-click on the question 
node > CREATE a new hotspot area. 

 

b. Clicking on this option puts the playback engine into editing 
mode, indicated by the 'INPUT MODE' display: 

 

c. While holding the left mouse button down at a position on 
the image on the right side of the Build8 screen, move the 
mouse over an area that is to be designated a hotspot 
area.  A red rectangular border with a red label will be 
drawn to provide feedback to the author: 
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d. The hotspot area is automatically labeled HSx_HS with a 
red border and a new button node labeled HSx is added to 
the SEGMENT BUILDER tree on the left side (where 'x' 
represents the hotspot number). 

6. The "Closed Caption Question" is used by courses that 
have authored closed captioning to be shown with video 
segments.  This question type can only be used one time in 
each course. Once the question has been used this menu 
option becomes greyed out and is no longer available.   
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a. To create the closed caption question, click Create > 
Segment > Question > Closed caption. 

 

The "Create Closed Caption Question" dialog box will appear. 

 

i. The closed caption question ID is pre-defined and 
entered in the "Test Question Segment ID" field 
by Build8, and cannot be changed. 

ii. If "Browse for Content File" is selected, the 
location of an HTML document file must be 
specified. 

iii. If "Enter Text Content" is selected instead, text 
can be typed directly into the window.  Clicking 
the "HTML" button will display the "Font" dialog 
where the various font attributes can be set for 
the text in the "Button" fields.  The window is pre-
populated with a standard question that can be 
changed as needed. 

iv. There are two response buttons that have been 
pre-populated down the right side of the dialog 
box.  The text can be changed as needed. 
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v. The location of an optional mp3 audio file may be 
specified by entering it in the "Audio File" field.  
Once the file has been selected, the time length 
of the audio file will be displayed in the 'selected 
audio length' window as an aid to the author. 

Creating a Segment with the SaveAs Function 
The "SAVEAS this question segment" option that appears on the segment 
node submenu allows the author to make a copy of the current segment then 
make minor changes to the question to create a new question, in order to 
expedite the authoring process.  A new Segment ID must be assigned in 
order to complete the "SAVEAS" operation.  
 

1. To get this submenu to use the "SAVEAS" function, right click 
on a segment node > SAVEAS this question segment. 

 

The "SaveAs Text Question" dialog box will appear. Click OK to save 
the segment.  
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Adding Answer Buttons to Questions 
Answer Buttons appear on the side of the question for the end-user to click to 
answer the question. They may also be words that come up on the screen for 
review menus. Each type of question has different types of answer buttons.  
Text and Graphic Questions can accommodate up to six button responses 
which appear on the left-hand side of the question window.  
 

1. To add a button, right-click on the question node > INSERT a 
new button into 1st position. 

 

The "Add Question Button" dialog box will appear. 

 

2. The button will be displayed as a button node in the 
SEGMENT BUILDER tree on the playback engine side of the 
screen.  The font attributes of the button label can be set by 
clicking the 'HTML' button. 
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3. To add another button to the list, right-click on the button that 
would come BEFORE the new button > INSERT a new 
button after this button. 

 

4. The button will be displayed as a button node in the 
SEGMENT BUILDER tree as well as on the playback engine 
side of the screen.  The font attributes of the button label can 
be set by clicking the 'HTML' button: 
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The new button will appear in the question.  

 

5. "Menu buttons" can to be added by right-clicking on a 
question node > INSERT a new button into 1st position. 
Menu questions are permitted to have up to eight button 
"responses". 

 

The "Add Question Button" dialog box will appear. 

 

6. The button will be displayed as a button node in the 
SEGMENT BUILDER tree and displayed on the playback 
engine side.  The font attributes of the button label can be set 
by clicking the 'HTML' button. 
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7. To add another button after the first button (and for any 
buttons after that), right click on the button node > INSERT a 
new button after this button. 

 

The "Add Question Button" dialog box will appear.  
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The new "menu button" will be added to the Review Menu. 

 

Designating a Correct Answer 
A question needs to have a correct answer designated in order for it to work 
properly in the course or to be included in the pretest/posttest/assessment 
test pool. The designated button label will become bolded and will be 
appended with the message "(correct ans)".  
  

1. To designate a correct answer for text and graphic questions, 
right click on the question node > DESIGNATE as correct 
answer. 

        

Text questions and graphic questions can only have one correct answer.  
 

2. To designate a correct answer for a hotspot question, right 
click on the question node > DESIGNATE as correct 
answer. 
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     

A designation of "(correct answer)" will be appended to the designated 
answer button. In addition, the label for the hotspot area on the right side of 
the Build8 screen will change from red to green.  There can be only one 
correct answer for this type of question.  

 

 
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3. Because of the unique nature of multiple/multiple choice 
questions  and sequential/multiple choice questions 

, there is additional information displayed next to the 
question ID label as an authoring aid, highlighting the correct 
answer response: 

 

Note: This is a visual reminder to the author that the 
answer sequence still needs to be set for this 
sequential/multiple choice question. 

 

 

Note: This is a visual reminder to the author as to 
what the correct hotspot areas are and that the 
responses can be given in any order for this 
multiple/multiple choice question. 

 

 

Note: This is a visual reminder to the author as to what 
the correct hotspot areas are and that the 
responses must be in sequence for this 
sequential/multiple choice question. 

4. To set the correct answer sequence for multiple/multiple 
choice questions, right click on the question node > SET 
correct answer sequence. 

Note: There must be at least 2 hotspot areas defined 
in order to enable this option. 
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The "Multiple Choice Answer Setup" dialog box will appear. 

 

5. The available hotspot responses are in the left column.  To 
create the answer array, highlight each available response and 
click on the '' button: 

 

In the above example, hotspot areas 2 and 4 represent the correct 
response and can be answered in either order.  This is a 
multiple/multiple choice question. 
 
If the answers must be selected in a specific order, the "Answers must 
be in exact sequence" checkbox must be checked.  This is a sequential/ 
multiple choice question.   
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To properly set up the question, available answers must be moved to 
the "Answer Array" in the order (from first to last) in which they must be 
selected by the end user when answering the question correctly. 

 

In the above example, hotspot areas 4 and 3 represent the correct 
response and must be selected in that exact order. 

Removing a Correct Answer 
1. To remove a button's designation as the correct answer, 

select either a different button as the correct answer or right-
click on the button 'REMOVE as correct answer: 

     

When removing a correct answer on hotspot questions, the label for the 
hotspot area on the right side of the Build8 screen will change back to red 
from green: 

             
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 

 

2. If a response needs to be removed from the answer array for 
a multiple/multiple choice question, highlight the response to 
remove in the 'Answer Array' and click the '' button: 

 202 



 

 

Correct responses are indicated by green labeling and incorrect responses 
are indicated by red labeling in the playback engine on the right side of the 
Build8 screen. 

 

Deleting a Button 
1. If a button is no longer needed or was added incorrectly, the 

author has the option to remove the button. To remove a 
question button, right click on the button > DELETE this 
button. 

 203 



 

       

2. Removing a button from a hotspot question is done similarly, 
right click on the button > DELETE this hotspot. 

     

Inserting a Segment 
1. To insert a segment into the current block, right click on the 

block node > INSERT a segment into block 1st position. 

 

2. To insert a question into a block, right click on the block node 
> INSERT a segment into block 1st position > insert 
QUESTION segment. 

 

The "Insert Question Segment" dialog box will appear.  
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 

        

3. To insert a slide into a block, right-click on the block node > 
INSERT a segment into block 1st position > insert SLIDE 
segment. 
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The "Insert Slide Segment" dialog box will appear.  

 

 

     

4. To insert a text segment into a block, right-click on the block 
node > INSERT a segment into block 1st position > insert 
TEXT segment. 
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The "Insert Text Segment" dialog box will appear.  

 

 

      

5. To insert a video segment into a block, right-click on the block 
node > INSERT a segment into block 1st position > insert 
VIDEO segment. 
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The "insert Video Segment" dialog box will appear.  

 

 

   

6. To insert the close caption question into the course to allow 
the option to have close captioning, right-click on the block 
node > insert QUESTION segment > ASK_CC_ENABLE. 
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The "Insert Question Segment" dialog box will appear.  

 

 

       

7. Inserting subsequent segments following the first one is done  
similarly to the way the first segment was inserted. Right 
clicking on the new segment brings up the submenu that gives 
the author a choice of inserting either a question, slide, text or 
video segment, or the contents of the "segment buffer" 
immediately following the current segment.  

To insert a segment after a slide. 

1. Right-click on the slide segment > INSERT a segment after 
this slide, then insert the type of segment or segment buffer. 
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 

 

2. Repeat this step for all the segments that get inserted into the 
block. 

To insert a segment after a text segment. 
 

1. Right-click on the text segment > INSERT a segment after 
this text, then insert the type of segment or segment buffer. 

 

 

 

2. Repeat this step for all segments that get inserted into the 
block. 
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To insert a segment after a video. 
 

1. Right-click on the video segment > INSERT a segment after 
this video, then insert the type of segment or segment buffer. 

 

2. Repeat this step for all segments that get inserted into the 
block. 

To insert a segment after a question. 
 

1. Right-click on the question segment > INSERT a segment 
after this question, then insert the type of segment or 
segment buffer. 

 

 

 

 

2. Repeat this step for all segments that get inserted into the 
block. 
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Segment Buffer 
You can hold any number of text, slide, video or question segments that you 
may want to reuse in other sections of the course by copying them into the 
"segment buffer".  

1. To copy one or more segments into the segment buffer, hold 
down the CTRL key and click on all of the segments that are to 
be put into the buffer. 

a. For example, the following question segment (Q02B) has 
four button responses, three of which are incorrect 
responses (buttons A, B and C).  To quickly copy the 
review segments from button A into buttons B and C: 

b. Simultaneously hold down the CTRL key 

c. Left-click on the slide segment (INCORR) 

d. Left-click on the video segment (FV02B) 

e. Release the CTRL key.  Segments that have been placed 
into the buffer will then be highlighted: 

       

2. In order to paste the contents of the segment buffer into the 
desired location, right-click at the node where the buffer 
contents are to be placed and choose the menu option 'insert 
SEGMENT BUFFER'.  In this example, right-click on button B 
and choose 'insert SEGMENT BUFFER': 

     
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3. Repeat this process for button C by right-clicking on button C 
and choosing 'insert SEGMENT BUFFER': 

     

Inserting a Review Segment 
A review segment is a segment that is attached to a question button, such as 
an incorrect screen, to provide feedback video associated with a question. 
There is no limit on how many review segments a button can have. Both 
incorrect and correct answers can have review segment attached to them.  
 

1. To insert a review segment, right click on the button > 
INSERT a review segment into 1st position. 

 
The menu will display a submenu that gives the author a choice of inserting a 
video, text, or slide segment or the contents of the segment buffer into the 
button response (these menu options have been previously discussed in the 
section "Inserting a Segment"). 
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 

 

 

 

Modifying a Segment 
Build8 allows for modification of any type of segment after it has been made. 
Modifications can be done to replace audio file, video file or slides if an 
incorrect one was selected or needs to be updated.  
 

1. To modify a segment, click Modify and then select the type of 
segment that needs to be modified.  

 

2. To modify a video segment, click Video. 
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The "Modify Video Segment" dialog box will appear.  
 

 

 

 
 

a. Modify the video segment ID if necessary.  All references 
to this segment will be automatically updated throughout 
the course logic tree. 

b. The location of the mp4 video file can be re-specified. 
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3. To modify a slide segment, click Modify > Slide. 

 

The "Modify Slide Segment" dialog box will appear.  

 

The "Modify Existing Slide Segment" dialog box will appear.  
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a. Modify the slide segment ID if necessary.  All references to 
this segment will be automatically updated throughout the 
Course Logic Tree. 

b. The location of the jpg graphic file can be re-specified. 

c. The segment timeout value can be re-specified. 

d. The audio mp3 file can be re-specified or audio can be 
disabled. 

4. To modify a text segment, click Modify > Text. 

 

The "Modify Text Segment" dialog box will appear. 
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The "Modify Existing Text Segment" dialog box will appear.  
 

 

a. Modify the text segment ID if necessary.  All references to 
this segment will be automatically updated throughout the 
Course Logic Tree. 

b. The location of the HTML document file can be re-specified 
or text content can be added. 

c. The segment timeout value can be re-specified. 

d. The audio mp3 file can be re-specified or audio can be 
disabled. 

5. To modify a question segment, click Modify > Question > 
MODIFY this question segment. 

     
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The "Modify Question Segment" dialog box will appear.  
 

 

 

 

a. Modify the question segment ID if necessary.  All 
references to this segment will be automatically updated 
throughout the course logic tree. 

b. Depending on the question type, the appropriate file type 
can be re-specified. 
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c. The associated module ID (that is used for assessment 
testing) can be re-specified. 

d. The audio mp3 file can be re-specified or audio can be 
disabled. 

6. If a new button needs to be added to a question, the only way 
to do it is to right-click on that question node > INSERT a new 
button into 1st position.  

 

The "Add Question Button" dialog box will appear. 

 

Replacing a Segment 
The author is able to change which segment is placed into the block by 
choosing to replace a current one. This can be done with slides, questions, 
video and text segments. 
 

1. To replace a slide segment with another slide segment, right-
click on the slide segment that is being replaced > 
REPLACE this slide segment. 
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The "Insert Slide Segment" dialog box will appear.  

 

 

            

2. To replace a text segment with another text segment, right-
click on the text segment that is being replaced > REPLACE 
this text segment. 
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The "Insert Text Segment" dialog box will appear.  
 

 

       

      

3. To replace a video segment with another video segment, right-
click on the video segment that is being replaced > 
REPLACE this video segment. 
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The "Insert Video Segment" dialog box will appear.  
 

 

   

        

4. To replace a question segment with another question 
segment, right-click on the question segment that is being 
replaced > REPLACE this question segment. 

 

The "Insert Question Segment" dialog box will appear.  
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 

        

Removing a Segment 
If a segment is no longer needed in the block, the author is able to remove it 
from the course logic.  This operation does not permanently delete the slide 
segment from the course. But simply removes it from the logic flow (to 
permanently delete the slide segment from the course see, "Deleting a 
Segment").  
 

1. To remove a slide segment from the course logic, right-click 
on the slide segment node > REMOVE this slide segment. 

      
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2. To remove a text segment from the course logic, right-click on 
the text segment node > REMOVE this text segment. 

        

3. To remove a text segment from the course logic, right-click on 
the video segment node > REMOVE this video segment. 

       

4. To remove a question segment from the course logic, right-
click on the question segment node> REMOVE this 
question segment. 

         

Deleting a Segment 
Any segment that is created is able to be deleted for any reason.  
 

1. To delete any segment, click Delete > Segment. 
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Deleting a video segment will permanently delete the selected video segment 
from the course.  All references to the selected video segment will be deleted 
from the course logic tree.  The associated video asset file will not be 
deleted. 
 

2. To delete a video segment, click Delete > Segment > Video. 

 

The "Delete Video Segment" dialog box will appear. 
  

 
Deleting a slide will permanently delete the selected slide segment from the 
course.  All references to the selected slide segment will be deleted from the 
course logic tree.  The associated slide asset file will not be deleted. 
 

3. To delete a slide, click on Delete > Segment > Slide. 
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The "Delete Slide Segment" dialog box will appear.  
 

 

Deleting a text segment will permanently delete the selected text segment 
from the course.  All references to the selected text segment will be deleted 
from the course logic tree. Any associated text asset file will not be deleted. 
 

4. To Delete a text segment, click Delete > Segment > Text. 

  

The "Delete Text Segment" dialog box will appear.  

 

 227 



 

Deleting a question will permanently delete the selected question segment 
from the course.  All references to the question segment will be deleted from 
the course logic tree.  Any associated question asset file will not be deleted. 
 

5. To delete a question, click Delete > Segment > Question. 

  

The "Delete Question Segment" dialog box will appear.  
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Reviewing the Course in Playback 
Playing a Course 
Once the course logic is completed, the author has the option to play the 
course in the playback window. This will play the course back just like the 
end-user will see it. Selecting "PLAY the entire course" will result in the course 
playing back from the beginning.  
 

1. To play the full course back, right-click on the course title 
node > PLAY the entire course. 

 

Playing a Module 
The bottom half of the Build8 screen also allows the author to play modules 
(chapters). Using this option begins playing the course from the beginning of 
the module.  

1. To play a specific module, right-click on the desired module > 
PLAY this module. 

 

Playing a Block 
The author also has the option to start playing the course from a block.  
 

1. To do this double-click the block node to begin playing the 
course from the beginning of that block or right-click on the 
block node > PLAY this block. 
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Post-test Review blocks are also able to be played.  

2. To play the posttest review block, right-click on POSTTEST_ 
REVIEW_BLOCK > PLAY this posttest review block. 

 

Playing a Segment 
The course logic tree also allows the author to play the course from a 
segment. This will start the course from the selected segment. If the option 
"Play next segment automatically" has been selected under "Build Options" it 
will play to the end of the course from the selected segment. If it is not 
selected, it will only play the selected segment. 
 

1. To play a slide segment, double-click or right-click on the slide 
segment node > PLAY this slide segment. 

 

2. To play a text segment, double-click or right-click on the text 
segment node > PLAY this text segment. 
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3. To play a video segment, double-click or right-click on the 
video segment node > PLAY this video segment. 

 

4. To play from a certain closed caption, right-click on the closed 
caption node > PLAY from this CC.  

 

Note: Closed captioning is associated with video playback and is 
an optional authoring feature.  In order to activate this 
feature, the author must include the "closed caption 
question" as described in section Inserting a Segment. 

5. To play a question segment, double-click or right-click on the 
question segment node > PLAY this question segment. 

 

6. To play a button's review segments, right-click on the button 
response node > PLAY this button.  
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Additional Build Functions 
There are several other functions in Build8 that can help authors to modify or 
create courses efficiently.  

Opening Another Course 
1. If a course is already open in Build8 and another course 

needs to be opened click on File > Open  

 

2. This brings up the "Build Course Titles" box. Click on the 
course in the lists that you want >  . 

 

3. Another way to open a course while another course is open is 
to hit the open course icon   on the icon bar. This will also 
display the "Build Course Titles" box. Click on the course in the 
list >  . 
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4. Right clicking on the title node in the course logic, the option 
"Open another course" becomes available. This option also 
displays the "Build course titles" dialog box which displays all 
of the CourseWorks course titles that are available for 
authoring.   

 

Saving a Course 
There are two ways to save a course so it is able to be used at a later time. 
This saves the course logic files for the current course to the hard-drive.  
 

1. To save a course click on File > Save or click on the save 
course icon  on the icon bar. 
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2. Another way save a course' is to use the "Save this course" 
option under a submenu that shows up when right clicking on 
the title node. To do this, right-click on the title node > Save 
the course. 

 

Build8 Options 
Build8 allows for font styles to be set so that the fonts in the course will be the 
same throughout. It also gives different options regarding how the course will 
function when new segments are created, such as whether a segment will 
play after being inserted or if the next segment is played automatically. 
 

1. To change these options click on File > Build Options 

 

This menu option displays the "Build Options" dialog box, which allows the 
author to set various attributes specific to the course currently being authored: 
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a. If "Play segment after insertion" is checked, Build8 will play 
back the newly inserted segment immediately for feedback 
review by the author.  If this option is unchecked, the newly 
inserted segment will not automatically play back after 
being inserted. 

b. If "Play next segment automatically" is checked, Build8 will 
play back the course segments in succession exactly as 
the end-user will see them in Deliver.  If this option is 
unchecked, when the current segment finishes play back, 
Build8 will not play the next segment. 

c. If "Auto backup of course files" is checked, Build8 will 
automatically save each iteration of the course logic files as 
backup. 

d. The "Set Font" button this is used to set various font 
attributes for the different text elements in the current 
course: 

i. First, select the text element whose attributes are 
to be set. 

ii. Click the 'Set Font' button to open the "Font" 
dialog box. 

 

iii. Choose the various attributes that you want in the 
"Font" dialog box. 
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iv. Click the OK button to save the selections. 

v. The attributes for the selected element will be 
displayed adjacent to the selected element as 
confirmation: 

 

e. The "Save settings to registry" button will save all of the text 
element settings for the course to the Registry for use by 
another course.  In this way, courses authored for a particular 
series can all have the same appearance. 

f. The "Restore settings from registry" function is used in 
conjunction with the "Save settings to registry" function.  
Clicking this button will set the settings for the various text 
elements in the current course to the text element settings that 
had been previously saved from another course. 
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Exiting Build 
1. To exit Build8 for any reason click File > Exit >Yes. 

  

The "Exit Build" dialog box will appear.  

 

Search a Course 
Build8 gives the author the option to search a course for a module, block or 
segment.  
 

1. To use this function, click View > Search. 

 

This displays the "Find Slide Segment" dialog box, listing all of the ID values 
for the selected element type (module, block, video, text, slide or question): 
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2. When an element ID is selected, all occurrences of that 
requested element type will be highlighted in the course logic 
tree. 

 
 

3. To clear a search, click View > Clear Search. 

 

4. This menu option removes all previous search results from the 
course logic tree by un-highlighting all tree nodes. 
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Technical Assistance 
If you have any questions regarding the CourseWorks® Learning 
Management System (LMS), Custom Pro, or a particular course your facility 
is using, contact the distributor from whom you purchased this software. 
Their staff has been trained to handle many common support issues. 
 
In the event the distributor's staff is not able to answer your question or help 
you solve your problem, they will call the Distributor Hotline at MARCOM. 
MARCOM's staff of distributor support personnel are trained to handle all 
types of support calls. MARCOM's Distributor Support Group is normally 
available between the hours of 8 a.m. and 5 p.m. Eastern Time, Monday 
through Friday. Contact information for MARCOM is: 
 

The MARCOM Group, Ltd. 
20 Creek Parkway 
Upper Chichester, PA 19061 
800/654-2448 or 610/859-8989 
FAX: 610/859-8106 
e-mail: service@marcomltd.com 
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Warranty/Disclaimer 
MARCOM's CourseWorks-based courses have been created to assist 
facilities that are endeavoring to educate their employees regarding good 
safety, health and human resource practices. The information contained in 
the courses is the information available to the producers of the course (The 
MARCOM Group, Ltd.) at the time of its production.  
 
All information in the courses should be reviewed for accuracy and 
appropriateness by facilities using the courses, to assure that it conforms to 
the facilities' situations and recommended procedures, as well as to any 
state, federal or other laws, standards and regulations governing their 
operations. There is no warranty, expressed or implied, that the information 
in the courses is accurate or appropriate for any particular facility's 
environment.  
 
The information in this document referring to course instruction, course 
operation and the functioning of the software has been carefully checked and 
is believed to be accurate. However the MARCOM Group, Ltd. assumes no 
responsibility for any inaccuracies that may appear in this material. 
Information provided in this document is subject to change without notice. 
 
The software discussed in this guide is furnished under a license agreement. 
The MARCOM Group, Ltd. assumes no liability for the content or use of 
programs created using this software (please refer to the terms of the 
software license accompanying this software). 
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Single End User License Agreement 
IMPORTANT. READ CAREFULLY. This End User License Agreement 
("Agreement") is a legal contract between you (either as a registered 
individual user or as the registered representative and on behalf of a single 
entity) and The MARCOM Group, Ltd. ("MARCOM") for the CourseWorks® 
software product identified above, which product includes computer software 
and may include associated media, printed materials, and "online" or 
electronic documentation ("software product"). By installing, copying, or 
otherwise using the software product, you agree to be bound by the terms of 
this Agreement. If you do not agree to the terms of this Agreement, then DO 
NOT install or use the software product. You may, however, return it to your 
place of purchase for a full refund. 

Software Product License 
The software product is protected by copyright laws and international 
copyright treaties, as well as other intellectual property laws and treaties. The 
software product is licensed, not sold.  
 
1) GRANT OF LICENSE. This Agreement grants you, the registered 
computer software user, the following rights: 
 
Applications Software. The software product may be used only by you.  You 
may install and use one copy of the software product, or any prior version 
thereof for the same operating system, on a single terminal connected to a 
computer but only for use in the number of written language(s) for which you 
have acquired rights therefore and selected at time of first installation.  You 
may not network the software product or otherwise use it on more than one 
computer or computer terminal at the same time unless you have arranged to 
purchase separate rights to do so.  In return for our license grant, you hereby 
irrevocably grant to MARCOM, and its affiliates, the non-exclusive, 
worldwide, fully-paid right to publicly disclose the fact that you are using the 
software product, including but not limited to the reproduction and distribution 
of the software 'screen shots' and/or 'box shots' from your applications, for 
MARCOM's advertising and other promotional purposes. 
 
Redistributable File(s).  Notwithstanding the terms of this Agreement to the 
contrary, certain of the executable files of the software product may be 
redistributed by you to the extent required for the permitted operation of the  
applications software installation code created by you while using the software 
product hereunder.  The specific redistributable file(s) are limited to those 
specifically identified as "Redistributables" in the media, printed materials, and 
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"online" or electronic documentation accompanying the particular embodiment 
of the software product. To determine whether a particular file(s) are 
redistributable, please contact the MARCOM's Distributor Support 
Department: The MARCOM Group, Ltd., 20 Creek Parkway, Upper 
Chichester, PA 19061, USA. 
 
Storage/Network Use. You may also store or install a copy of the software 
product on a storage device, such as a network server, used only to install or 
run the software product on your other computers over an internal network; 
buy only if you have acquired a specific license for the appropriate number of 
concurrent accesses to the software product from the storage device. Any 
given license for the software product may not be shared or used 
concurrently or otherwise on different computers or by different users in a 
given organization. 
 
License Pack. If you have acquired this Agreement in a License Pack, you 
may make the number of additional copies of the computer software portion 
of the software product identified in your purchase documentation, and you 
may use each copy in the manner specified therein. 
 
2) DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. Limitations on 
Reverse Engineering, Decompilation, and Disassembly. You may not modify, 
reverse engineer, decompile, or disassemble the software product, except 
and only to the extent that such activity is expressly permitted by applicable 
law notwithstanding this limitation of components. The software product is 
licensed as a single product. Its component parts may not be separated for 
use on more than one computer. 
 
Not for Resale Software. You may not use the software product for 
commercial purposes nor sell, or otherwise transfer it for value.  Commercial 
purposes include the use of the software product in the creation of publicly or 
privately distributed computer software. If you wish to incorporate this 
software into products that will be sold or otherwise distributed publicly or 
privately, you must execute a contract to that end with MARCOM.  
 
Rental. You may not rent, lease, or lend the software product to any party. 
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Software Transfer. You may permanently transfer all of your rights under this 
Agreement, provided you (a) retain no copies, (b) transfer all of the software 
product (including all component parts, the media and printed materials, any 
upgrades, this Agreement, and, if applicable, the Certificate of Authenticity), 
and (c) the recipient agrees to abide by all of the terms of this Agreement. If 
the software product is an upgrade, any transfer must include all prior 
versions of the software product and all of your rights therein, if any. 
 
Support Services. MARCOM may provide you with support services related 
to the software product ("Support Services"). The provision and use of 
Support Services is governed by the MARCOM policies and programs 
described in the software product user manual and/or in "online" 
documentation. Any supplemental software code provided to you as part of 
the Support Services shall be considered part of the software product and is 
subject to the terms and conditions of this Agreement. With respect to 
technical information you provide to MARCOM as part of the Support 
Services, MARCOM may use such information for its business purpose, 
including for product updates and development. MARCOM will use its best 
efforts to not utilize such technical information in a form that personally 
identifies you. 
 
Termination. Without prejudice to any of MARCOM's other rights, MARCOM 
may terminate this Agreement if you fail to comply with the terms and 
conditions of this Agreement. In such event, you must destroy all copies of 
the software product and all of its component parts; to this end you grant to 
MARCOM the right to, with or without notice, monitor your Internet accessible 
activities for the purpose of verifying software product performance and/or 
your compliance with the terms hereof, including, but not limited to the 
remote monitoring and verification of your implementation, use and 
duplication of the software product. 
 
3) UPGRADES. If the software product is labeled or otherwise identified by 
MARCOM as an "upgrade", you must be properly licensed to use a product 
identified by MARCOM as being eligible for the upgrade in order to use the 
software product. A software product labeled or otherwise identified by 
MARCOM as an upgrade replaces and/or supplements the product that 
formed the basis for your eligibility for such upgrade. You may use the 
resulting upgraded product only in accordance with the terms of this 
Agreement. If the software product is an upgrade of a component of a 
package of software programs that you licensed as a single product, the 
software product may be used and transferred only as part of that single 
product package and may not be separated for use on more than one 
computer. 
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4) COPYRIGHT AND TRADEMARKS. All title, trademarks and copyrights in 
and pertaining to the software product (including but not limited to any 
images, photographs, animation, video, audio, music, text, and applets 
incorporated into the software product), the accompanying, printed materials 
and any copies of the software product are owned by MARCOM or its 
affiliated companies. The software product is protected by copyright and 
trademark laws and international treaty provisions. You must treat the 
software product like any other copyrighted product for archival purposes, 
and you may not copy the printed materials accompanying the software 
product unless explicitly given permission to do so in writing by MARCOM. 
You may not remove, modify or alter any MARCOM copyright or trademark 
notice from any part of the software product, including but not limited to any 
such notices contained in the physical and/or electronic media or 
documentation, in the MARCOM Setup Wizard dialogue or 'about' boxes, in 
any of the runtime resources and/or in any web-presence or web-enabled 
notices, code or other embodiments originally contained in or dynamically or 
otherwise created by the software product. 
 
5) DUAL-MEDIA SOFTWARE. You may receive the software product in 
more than one medium. Regardless of the type or size of the medium you 
receive, you may use only that one medium that is appropriate for your single 
computer. You may not use or install the other medium on another computer, 
including but not limited to portable computers under the exclusive control of 
the registered user.  You may not loan, rent, lease, or otherwise transfer the 
other medium to another user, except as part of the permanent transfer (as 
provided above) of the software product. 
 
6) U. S. GOVERNMENT RESTRICTED RIGHTS. The software product and 
documentation are provided with restricted rights. Use, duplication, or 
disclosure by the U. S. Government is subject to restrictions as set forth in 
subparagraph C (1)(ii) of the Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c) (1) and (2) of 
the Commercial Computer Software – Restricted Rights at 48 CFR 52.227-
19, as applicable. The Manufacturer is: The MARCOM Group, Ltd., 20 Creek 
Parkway, Upper Chichester, PA 19061, USA. 
 
7) MISCELLANEOUS. If you acquired or use this software product in the 
United States, this Agreement is governed by the laws of the State of 
Delaware.  If this software product was acquired and is used exclusively 
outside of the United States, then local law may also apply. Should you have 
any questions concerning this Agreement, or if you desire to contact 
MARCOM for any reason, please contact the MARCOM distributor from 
whom you purchased this software product, or write: The MARCOM Group, 
Ltd., 20 Creek Parkway, Upper Chichester, PA 19061, USA. 
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8) LIMITED WARRANTY. 
Limited Warranty. MARCOM warrants that (a) the software product will 
perform substantially in accordance with the accompanying written materials 
for a period of ninety (90) days from the date of receipt, when installed on 
supported computer equipment and systems software as described in the 
software's installation procedures, and (b) any Support Services provided by 
MARCOM shall be substantially as described in applicable written materials 
provided to you by MARCOM, and (c) MARCOM technical support personnel 
will make commercially reasonable efforts to solve any problem issues with 
the software product. MARCOM does not warrant that operation of the 
software will be uninterrupted or error-free, or that all errors will be corrected. 
To the extent that implied warranties on the software product are 
disclaimable, they are disclaimed herein below.  Some states and 
jurisdictions do not allow disclaimers of or limitations on the duration of an 
implied warranty, so the above limitation may not apply to you. To the extent 
implied warranties may not be entirely disclaimed but implied warranty 
limitations are allowed by applicable law, implied warranties on the software 
product, if any, are limited to ninety (90) days. 
 
Customer Remedies. MARCOM's, its suppliers' and resellers'/distributors' 
entire liability and your exclusive remedy shall be, at MARCOM's option, 
either (a) return of the price paid by you for the software product (not to 
exceed the suggested retail price) if any, or (b) repair (if you report a failure 
to MARCOM within the warranty period, and upon request, provide sufficient 
information, which may include access to your computer system for use of 
copies of the software by MARCOM personnel to reproduce the defect in 
question), or (c) replacement of the component(s) of the software product 
that do(es) not meet MARCOM's limited warranty criteria and which is 
returned to MARCOM with a copy of your purchase receipt.  
 
This Limited Warranty is void if failure of the software product has resulted 
from accident, abuse, or misapplication. Any replacement software product 
will be warranted for the remainder of the original warranty period or thirty 
(30) days, whichever is longer. Outside of the United States, neither of these 
remedies nor any product support services offered by MARCOM are 
available without proof of purchase from an MARCOM authorized 
international source. 
 
MARCOM disclaims all other warranties, either expressed or implied, 
including but not limited to implied warranties of merchantability and fitness 
for a particular purpose, with respect to the software and the accompanying 
written materials.  
 

 245 



 

No Other Warranties. To the maximum extent permitted by applicable law, 
MARCOM and its suppliers also disclaim all other warranties and conditions, 
either express or implied, including, but not limited to, implied warranties of 
merchantability, fitness for a particular purpose, title, and non-infringement, 
with regard to the software product and the provision of or failure to provide 
support services. This limited warranty gives you specific legal rights. You 
may have others, which vary from state/jurisdiction to state/jurisdiction. 
 
9)  LIMITATION OF LIABILITY. To the maximum extent permitted by 
applicable law, in no event shall MARCOM, its suppliers or 
resellers/distributors be liable for any special, incidental, indirect, or 
consequential damages whatsoever (including, without limitation, damages 
for loss of business profits, business interruption, loss of business 
information, or any other pecuniary loss) arising out of the use of or inability 
to use this software product or the provision of or failure to provide support 
services, even if MARCOM has been advised of the possibility of such 
damages. In any case, MARCOM's entire liability under any provision of this 
agreement shall be limited to the greater of the amount actually paid by you 
for the software product or ten United States Dollars (U.S. $10.00); provided, 
however, if you have entered into a MARCOM support services agreement, 
MARCOM's entire liability regarding support services shall, be governed by 
the terms of that agreement. Because some states and jurisdictions do not 
allow the exclusion or limitation of liability, the above limitation may not apply 
to you. 
 
10) WHOLE AGREEMENT. This agreement is the entire agreement between 
you and MARCOM with respect to its subject matter and supersedes all prior 
and contemporaneous proposals, statements and agreements. This 
agreement shall be governed by the laws of the State of Delaware, as a 
contract made and performed therein. Should you have any questions 
concerning this agreement, please write to: The MARCOM Group, Ltd., 20 
Creek Parkway, Upper Chichester, PA 19061, USA. 
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